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Product Certifications
UL, cUL, TÜV, CE, C-Tick, meets or exceeds FCC Class B Requirements
Laser: CDRH

Laser Safety
This unit employs a laser. Do not remove the cover or attempt to service this device when 
connected due to the possibility of eye damage.

Laser-Sicherheit
In das Gerät ist ein Laser eingebaut. Nehmen Sie die Abdeckung nicht ab und versuchen Sie 
nicht, das Gerät zu reparieren, solange es angeschlossen ist. Es besteht die Gefahr einer 
Augenverletzung.

CAUTION
Use of controls or adjustments or performance of procedures other than those specified herein 
may result in hazardous laser radiation exposure.

WARNUNG
Die Vornahme von Regelungen oder Einstellungen oder die Durchführung von Verfahren, die 
nicht in diesem Dokument angegeben sind, kann eine gefährliche Einwirkung von 
Laserstrahlung zur Folge haben.

Class 1 Laser Product
Klass 1 Laserapparat
Luokan 1 Laserlaite
Klasse 1 Laser-Produkt

DANGER: INVISIBLE LASER RADIATION WHEN OPEN. AVOID DIRECT EXPOSURE TO BEAM.
DANGER: RADIATIONS INVISIBLES DU LASER EN CAS D’OUVERTURE. EVITER TOUT 
EXPOSITION DIRECTE AU FAISCEAU.
VORSICHT: UNSICHTBARE LASERSTRAHLUNG, WENN ABDECKUNG GEÖFFNET. NICHT 
DEM STRAHL AUSSETZEN.
ADVARSEL: USYNLIG LASERSTRÅLING VED ÅBNING. UNDGÅ UDS/ETTELSE FOR STRÅLING.
ADVARSEL: USYNLIG LASERSTRÅLING NÅR DEKSEL ÅPNES. UNNGÅ EKSPONERING FOR 
STRÅLEN.
VARNING: OSYNLIG LASERSTRÅLNING NÄR DENNA DEL ÄR ÖPPNAD. STRÅLEN ÄR FARLIG.
VARO! NÄKYMÄTÖN AVATTAESSA OLET ALTTIINA LASERSÄTEILYLLE. ÄLÄ KATSO SÄTEESEN.

Laser
Type: Semiconductor laser GaAlAs
Wave length: 778~787 nm (at 25°C)
Output power: 2.5 mW (read), 35 mW (write)
Beam divergence: 60 degrees

Notice
Europe: This drive shall be installed only with an EN60950 (IEC950) approved power supply.

USA/Canada: This drive is for use only with IBM compatible UL listed personal computers, 
weighing less than 18 kg.
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Federal Communications Commission R.F. Interference Statement
WARNING: This equipment has been tested and found to comply with the limits for a Class B 
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This equipment 
generates, uses and can radiate radio frequency energy and, if not installed and used in 
accordance with the instructions, may cause harmful interference to radio communications. 
However, there is no guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

■ Reorient or relocate the receiving antenna.
■ Increase the separation between the equipment and receiver.
■ Connect the equipment into an outlet on a circuit different from that to 

which the receiver is connected.
■ Consult the dealer or an experienced radio/TV technician for help.

CAUTION: Changes or modifications to this equipment not expressly approved by Hewlett-
Packard could result in violation of Part 15 of the FCC rules.

DECLARATION OF CONFORMITY
according to ISO/IEC Guide 22 and EN 45014

Manufacturer’s Name:

Manufacturer’s Address:

declares that the product:
   Product Name:
   Product Number:
   Product Options:

Hewlett-Packard Company
Colorado Memory Systems Division

800 S. Taft Ave.
Loveland, Colorado 80537

HP SureStore CD-Writer Plus 8100i
C4392-56000, C4400-56000
All

conforms to the following Product Specifications:

Safety:

EMC:

Supplementary Information

EN60950 A3:1995
EN60825-1:1994

CISPR 22:1993/EN 55022:1994 Class B
EN 50082-1:1992
   IEC 801-2:1991 - 4kV CD, 8kV AD
   IEC 801-3:1984 - 3V/m
   IEC 801-4:1988 
       1kV Power Lines
        0.5kV Signal Lines
ENV 50140:1993 - 3V/m
FCC Part 15 Class B
AS/NZS 3548: 1995
IEC 555-2

The product herewith complies with the requirements of the EMC Directive 89/336/EEC and carries 
the “CE” mark accordingly.

July 01, 1998 Nicholas Balogh, Manufacturing Manager

European contact: Your local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, 
Department HQ-TRE, Herrenberger Straβe 130, D-71034 Böblingen (FAX: +49-7031-143143).
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FCC Declaration of Conformity
According to 47CFR, Parts 2 and 15, Class B Computer Peripherals: 
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful interference (2) this device must accept any 
interference received including interference that may cause undesired operations. This applies to 
all product options.

Hewlett-Packard Company
Colorado Memory Systems Division
800 S. Taft Ave.
Loveland, Colorado 80537
USA
Telephone 970-635-1500

July 1, 1998
Nicholas Balogh, Manufacturing Manager

Canadian Standards Association Information Statement
INSTRUCTION TO USER:
WARNING: This component is only considered to be approved when installed in CSA certified 
equipment evaluated to the standards C22.2 No. 220-M1986 or C22.2 No. 950-M89. The 
operator accessibility into the end use enclosure is defined with strict accordance in the 
operator's manual for the installation of components into the equipment.

BAPT Statement
Diese Ausrüstung erfüllt die Europäischen EMC-Bestimmungen für die Verwendung in folgender 
/ folgenden Umgebung(en):

■ Wohngegenden
■ Gewerbegebiete
■ Leichtindustriegebiete

(Diese Ausrüstung erfüllt die Bestimmungen der Norm EN55022, Klasse B.)

Korean RRL Statement

Copyright notice for Denmark:

VIGTIGT! 

Copyright ved brug af CD-Writer 8100i/e enheder solgt i Danmark
I henhold til gældende dansk lov om ophavsret er det forbudt at foretage digital kopiering af et 
digitalt værk. CD-RW brænderen må derfor IKKE anvendes til at kopiere en musik-CD. CD-RW 
brænderen må desuden kun benyttes til at kopiere et digitalt EDB-program, når en sådan 
kopiering tjener til at fremstille et sikkerhedseksemplar af programmet eller hvor kopiering er 
nødvendig, for at programmet kan anvendes efter dets formål. Hvis De selv har ophavsretten til 
værket, har De også retten til at foretage digital kopiering med CD-RW brænderen.
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Hewlett-Packard Limited Warranty Statement

HP SureStore CD-Writer Plus Drive
DURATION OF LIMITED WARRANTY           Hardware - 1 year      Software - 90 days

1.   HP warrants to you, the end-user customer, that HP hardware, accessories and 
supplies will be free from defects in materials and workmanship after the date of 
purchase, for the period specified above. If HP receives notice of such defects 
during the warranty period, HP will, at its option, either repair or replace products 
which prove to be defective. Replacement products may be either new or like-new.

2.   HP warrants to you that HP software will not fail to execute its programming 
instructions after the date of purchase, for the period specified above, due to 
defects in material and workmanship when properly installed and used. If HP 
receives notice of such defects during the warranty period, HP will replace 
software media which does not execute its programming instructions due to such 
defects.

3.   HP does not warrant that the operation of HP products will be uninterrupted 
or error free. If HP is unable, within a reasonable time, to repair or replace any 
product to a condition as warranted, you will be entitled to a refund of the 
purchase price upon prompt return of the product.

4.   HP products may contain remanufactured parts equivalent to new in 
performance or may have been subject to incidental use.

5.   Warranty does not apply to defects resulting from (a) improper or inadequate 
maintenance or calibration, (b) software, interfacing, parts or supplies not 
supplied by HP, (c) unauthorized modification or misuse, (d) operation outside of 
the published environmental specifications for the product, or (e) improper site 
preparation or maintenance.

6.   HP MAKES NO OTHER EXPRESS WARRANTY OR CONDITION WHETHER 
WRITTEN OR ORAL. TO THE EXTENT ALLOWED BY LOCAL LAW, ANY IMPLIED 
WARRANTY OR CONDITION OF MERCHANTABILITY, SATISFACTORY QUALITY, 
OR FITNESS FOR A PARTICULAR PURPOSE IS LIMITED TO THE DURATION OF 
THE EXPRESS WARRANTY SET FORTH ABOVE. Some countries, states or provinces 
do not allow limitations on the duration of an implied warranty, so the above 
limitation or exclusion might not apply to you. This warranty gives you specific 
legal rights and you might also have other rights that vary from country to 
country, state to state, or province to province.

7.   TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS 
WARRANTY STATEMENT ARE YOUR SOLE AND EXCLUSIVE REMEDIES. EXCEPT 
AS INDICATED ABOVE, IN NO EVENT WILL HP OR ITS SUPPLIERS BE LIABLE 
FOR LOSS OF DATA OR FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL 
(INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE, WHETHER BASED 
IN CONTRACT, TORT, OR OTHERWISE. Some countries, States or provinces do 
not allow the exclusion or limitation of incidental or consequential damages, so 
the above limitation or exclusion may not apply to you.

FOR CONSUMER TRANSACTIONS IN AUSTRALIA AND NEW ZEALAND: THE 
WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT 
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN 
ADDITION TO THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE 
SALE OF THIS PRODUCT TO YOU.
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HP Software License Agreement
ATTENTION: USE OF THE SOFTWARE IS SUBJECT TO THE HP SOFTWARE LICENSE TERMS SET 
FORTH BELOW. USING THE SOFTWARE INDICATES YOUR ACCEPTANCE OF THESE LICENSE 
TERMS. IF YOU DO NOT ACCEPT THESE LICENSE TERMS, YOU MAY RETURN THE SOFTWARE 
FOR A FULL REFUND. IF THE SOFTWARE IS BUNDLED WITH ANOTHER PRODUCT, YOU MAY 
RETURN THE ENTIRE UNUSED PRODUCT FOR A FULL REFUND. 

HP SOFTWARE LICENSE TERMS

License Grant. HP grants you a license to Use one copy of the Software. “Use” means storing, 
loading, installing, executing or displaying the Software. You may not modify the Software or 
disable any licensing or control features of the Software.

Ownership. The Software is owned and copyrighted by HP or its third party suppliers. Your 
license confers no title or ownership in the Software and is not a sale of any rights in the 
Software. HP's third party suppliers may protect their rights in the event of any violation of these 
License Terms.

Copies and Adaptations. You may only make copies or adaptations of the Software for archival 
purposes or when copying or adaptation is an essential step in the authorized Use of the 
Software. You must reproduce all copyright notices in the original Software on all copies or 
adaptations. You may not copy the Software onto any bulletin board or similar system.

No Disassembly or Decryption. You may not disassemble or decompile the Software unless HP's 
prior written consent is obtained. In some jurisdictions, HP's consent may not be required for 
limited disassembly or decompilation. Upon request, you will provide HP with reasonably 
detailed information regarding any disassembly or decompilation. You may not decrypt the 
Software unless decryption is a necessary part of the operation of the Software.

Transfer. Your license will automatically terminate upon any transfer of the Software. Upon 
transfer, you must deliver the Software, including any copies and related documentation, to the 
transferee. The transferee must accept these License Terms as a condition to the transfer. 

Termination. HP may terminate your license upon notice for failure to comply with any of these 
License Terms. Upon termination, you must immediately destroy the Software, together with all 
copies, adaptations and merged portions in any form.

Export Requirements. You may not export or re-export the Software or any copy or adaptation 
in violation of any applicable laws or regulations.

U.S. Government Restricted Rights. The Software and any accompanying documentation have 
been developed entirely at private expense. They are delivered and licensed as “commercial 
computer software” as defined in DFARS 252.227-7013 (Oct 1988), DFARS 252.211-7015 (May 
1991) or DFARS 252.227-7014 (Jun 1995), as a “commercial item” as defined in FAR 2.101(a), or 
as “Restricted computer software” as defined in FAR 52.227-19 (Jun 1987)(or any equivalent 
agency regulation or contract clause), whichever is applicable. You have only those rights 
provided for such Software and any accompanying documentation by the applicable FAR or 
DFARS clause or the HP standard software agreement for the product involved.
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Chapter 1:
Installing CD-Writer 
Plus and Software

What’s in the Package
Make sure you have the items shown below. (Keep the packaging in case 
you need to transport the CD-Writer Plus drive.)

NOTE: You may not need the data cable and the audio cable depending on your 
computer’s configuration.

User’s 

Blank
ReWritable

HP SureStore CD-Writer Plus drive
Screws

Guide  

CD
CD

Data cable 

 

 
  
 

Software 
installation CDs

Blank
Recordable

Audio
Cable

Disaster Recovery
Storage Pack



1-2 Tools You’ll Need

Tools You’ll Need
Locate the following items, before you begin to install the drive:

■ A medium-size Phillips screwdriver

■ Your computer system’s manual (you may need to look up 
information about the location of your IDE connectors)

Before You Begin
Before you begin the installation you need to decide whether you will be 
installing the CD-Writer Plus in an empty drive bay, or whether you will 
be replacing an existing CD-ROM with the CD-Writer Plus drive. To 
install the CD-Writer Plus:

■ In an empty drive bay, see page 1-3.

■ As a replacement for an existing CD-ROM, see page 1-20. 

NOTE: In the Toshiba Infinita and IBM Aptiva computers, install the CD-
Writer Plus in an empty drive bay, and not as a replacement for an existing CD-
ROM drive. Because of the fit between the CD-Writer Plus and these computers 
it may not be possible to replace the CD-ROM drive with the CD-Writer Plus 
drive.
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Installing a CD-Writer Plus in an Empty 
Drive Bay

Follow the instructions in this section if you will be adding a CD-Writer 
Plus to your computer (not replacing a CD-ROM).

Watching the Installation Video

1. Insert the CD labeled Software Disc 1 into your CD-ROM drive (not the 
CD-Writer Plus drive). The main menu appears:

If the main menu does not appear automatically, click on the Start 
button on the task bar, select Run, type D:\SETUP (where D: is your CD 
drive’s letter), then click on OK. 

If your computer does not have a CD-ROM drive, see page  A-1.
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2. Watch the installation video (about 6 minutes). To do this, click on the 
Before You Install icon and then click on the Watch Installation Video 
icon.

If you would like to, explore some of the other information options that 
appear on the screen.

Getting an Install Recommendation

CD-Writer Plus’ installation program will analyze your computer and 
make a recommendation about connecting the CD-Writer Plus hardware. 
This recommendation is specific to your computer and is the first step in 
successfully installing CD-Writer Plus.

1. Go back to the main menu and click on the Install CD-Writer Plus icon.

2. Follow the instructions on the screen. 

3. When the CD-Writer Plus Install Recommendation screen appears, click 
Print. Or, if you don’t have a printer, copy the information by hand. 
You’ll need this information in the next section.

Before You
Install icon

Watch Installation
Video icon

Install CD-Writer Plus icon
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Installing the Hardware

CAUTION: The discharge of static electricity can damage electronic circuitry. 
You can avoid static discharge by touching a grounded metal object such as 
your computer’s case before and during installation of hardware inside your 
computer or by wearing a grounding strap connected to ground.

1A. After getting the Install Recommendation (see the previous section) you 
will be prompted to shut down Windows. Click the Shutdown button 
and wait until it is safe to turn off your computer. Proceed to turn OFF 
your computer, monitor, and other devices. 

2A. Unplug the power cords from the wall outlet or from the power strip, if 
you use one. 

3A. Remove the cover from your computer

CAUTION: Be careful of any sharp edges that may be present inside your 
computer.

See your computer’s 
manual if you need help
removing the cover.

Computer OFF
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4A. Remove the cover plate from a larger half-height drive bay.

5A. Look at the other drives that are installed in your computer to see if your 
computer’s case requires rails or mounting brackets to hold a drive in 
place. If it does, use an extra set of rails that came with your computer 
and attach them to the sides of CD-Writer Plus. If you do not have an 
extra set, contact your computer’s manufacturer to obtain rails.

Available half-height drive bay

See your computer’s 
manual if you need help
removing the drive bay cover.

(approx. 6” x 1.75”/15cm x 4.5 cm)
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6A. Write down the CD-Writer Plus’ serial number in the space below. The 
serial number is on the main label on the top of the drive.

7A. Read the Install Recommendation you printed earlier (see page 1-4). The 
Install Recommendation tells you whether the jumper on the CD-Writer 
Plus should be set as Master or Slave for your computer.

8A. Find the pairs of pins labeled Master, Slave, and Cable Select on the back 
of the CD-Writer Plus. Notice that one pair of pins has a small plastic cap 
or jumper. This jumper can be pulled off using your fingers, tweezers, or 
needlenose pliers, and placed on a different pair of pins to change the 
setting.

Serial 
number:

Drive’s serial number
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9A. Set the jumper on the CD-Writer Plus as advised in the Install 
Recommendation Printout for your computer (page 1-4).

or Master
Check the back of the new drive and 
make sure the jumper is on the right-
hand location (Master).

Don’t use
Cable Select

This is a jumper. You can pull
it off and place it on another
pair of pins to change the setting.

Slave
Check the back of the new drive and 
make sure the jumper is on the center 
location (Slave).
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10A. Insert the drive into the selected drive bay. Be careful not to dislodge any 
cables inside your computer as you do this.

11A. Look at the Install Recommendation Printout (see page 1-4) again and 
find whether the data cable should be connected to the primary or 
secondary IDE controller on your computer.

TIP (for Two Devices connected to the data cable): If the Install 
Recommendation states that your CD-Writer Plus drive will share the data 
cable with another device (such as a CD-ROM drive), follow the cable already 
attached to the other device down to the circuit board in order to locate the IDE 
controller that you need. If you find an extra connector along that cable, simply 
attach that connector to the CD-Writer Plus drive.
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12A. Locate the recommended 40-pin IDE controller (primary or secondary) 
on your computer’s motherboard.

The IDE connectors are on the motherboard, which is the largest circuit 
board in your computer, taking up most of the bottom of a desktop 
computer or the side of a tower computer.

IDE connectors are usually found in pairs and may look like any of the 
following:

(Actual size)

manual if you need
See your computer’s

IDE connectors

help finding the
IDE connector

You will see a variety of connectors 
inside your computer that look similar 
to the 40-pin connector but have more 
or fewer pins. Find the connectors that 
are the correct size to fit the cable that 
came in the box with your drive.
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The IDE connectors may be hidden by some of the computer’s cables or 
may be behind a drive. 

Many computers have an IDE hard drive or CD-ROM that connects to 
the motherboard through an IDE controller. The data cables on these 
drives have the same width as the data cable included with your CD-
Writer Plus. If your computer has an IDE hard drive or CD-ROM drive, 
you can follow the data cable from the back of one of those drives and 
find the IDE controller that connects it to the motherboard. 

Computer manufacturers use a wide variety of labels for IDE connectors! 
Look on your computer’s circuit boards for printing identifying the 
primary and secondary connectors, such as:
- PRI and SEC 
- IDE-0 and IDE-1
- IDE-1 and IDE-2
- HD and CD-ROM (most common devices to be attached)
- PCI-IDE and ISA-IDE

13A. Refer to the Install Recommendation Printout (see page 1-4) to see if you 
will have one or two devices connected to the data cable.

On page 1-13 you can see what a One Device installation looks like 
compared to a Two Device installation.

14A. Make the necessary data cable connections for your system.

CAUTION: Do not attach the CD-Writer Plus drive to a sound board’s IDE 
controller.

Most data cable connectors are keyed to fit only one way. If your 
connector is not keyed to fit only one way make sure the cable’s colored 
edge is aligned with PIN-1 where it connects to the CD-Writer Plus drive 
and where it connects to the IDE controller on the motherboard. Among 
the labels you may find that identify PIN-1 on the motherboard are PIN1, 
1 or a small triangle pointing to the pin.

CAUTION: Make sure that you are attaching the cable correctly! You must 
locate PIN-1 on each connector and attach the cable so that the edge with the 
color stripe is aligned with PIN-1. If the cable is attached incorrectly, your 
computer may not boot up.
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PIN-1
Look for a label identifying PIN-1 on 
your computer. The data cable’s 
colored edge is aligned with PIN-1 of 
the IDE connector. This illustration 
shows a specific computer. Yours may 
look different. PIN-1 could be on 
either side of the IDE connector.

colored stripe on
the data cable

PIN-1
The cable’s colored edge is aligned 
with PIN-1 on the CD-Writer Plus 
drive.

Colored stripe on
the data cable
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One Device
The OPTIONAL data cable that came with the 
CD-Writer Plus drive is only used if there is no 
cable already attached to the recommended 
IDE controller in your computer system or 
the cable supplied with your computer is not 
long enough.

Use the connectors at the two ends of the 
cable.

Two Devices
Attach the CD-Writer Plus to whichever 
connector is not in use (center or end) on the 
data cable already installed in your computer 
(DO NOT swap connectors).

The OPTIONAL data cable that came with the 
CD-Writer Plus is only used if there is no spare 
connector for the CD-Writer Plus on your 
cable or your cable is not long enough.

CD-Writer Plus

Colored stripe
aligned with 

CD-Writer Plus

IDE controller

Colored stripe
aligns with

Follow the 
data cable 
already
attached to the

in your

each PIN-1

PIN-1

PIN-1

computer to
locate the IDE 
controller.

PIN-1

PIN-1

each PIN-1

located inside
your computer

IDE controller
located inside
your computer

PIN-1

other IDE device

Unused connector

drive (on end connector) drive (either location
not in use)

MotherboardMotherboard

Drive

DriveDrive
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15A. Find an unused power cable inside 
your computer. There are a few 
unused power cables like the one 
shown inside most computers. 

NOTE: If you do not have an 
available power connector, you will 
need to purchase a Y-power cable that 
expands one power connector into 
two. Call your local computer 
hardware vendor to purchase one. 

16A. Plug the power cable into the back of the drive, with the beveled edge up.

Beveled
edge

Red, yellow, 
and black wires

Power cable 

Beveled edge up
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17A. If you do not have a sound board or only want to 
listen to music discs using headphones or speakers 
attached to the front of the CD-Writer Plus, skip 
this step and go to step 18A.

You do not need an audio cable to record music. 
The audio cable is used only for listening to music 
CDs through your computer’s sound system. 
When the CD-Writer Plus drive records music or data, it uses the data 
cable, not the audio cable.

Using an existing audio cable

If your sound board already has a spare audio cable with an MPC-2 
connector (shown above), plug the MPC-2 connector it into the Audio 
Out opening on the back of the CD-Writer Plus drive.

Using the audio cable provided with your CD-Writer Plus

To use the audio cable that came with your CD-Writer Plus, first plug the 
end with only one connector to the Audio Out opening on the back of 
the CD-Writer Plus drive.

 

MPC-2 connector

Audio
cable
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Next, connect the other end of the audio cable to the sound board inside 
your computer.

Tips for connecting the audio cable to the sound board

■ Identify the sound board.

To identify the sound board look for microphone connectors on the back 
of your computer. The circuit board inside the computer attached to the 
microphone connectors is the sound board.

Sound board

The large connector or the small connector

sound board. Use only one connector.

“CD-IN” horizontal
connector

“CD-IN” vertical
connector

Audio
cable

may be the one that works for your
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■ Identify the audio connectors on the sound board.

The audio connectors have four prongs and are often on the outer edge 
of the sound board. On many sound boards the connectors for the audio 
cable are labeled CD IN.

■ Select the connector on the audio cable that fits your sound board.

The audio cable has two connectors in order to work with most sound 
boards. Try to match one of them to a connector on your sound board.

The audio cable may connect horizontally or vertically to the sound 
board. The connectors only fit one way. If a connector doesn’t fit, try 
turning it around. 

Use only one of the two connectors on this end of the audio cable. 
Simply leave the connector you don’t use unattached.

■ Some sound boards have more than one audio cable connector. If when 
you turn your computer back on you get no sound, try using a different 
connector on your sound board.

NOTE: The audio cable provided with CD-Writer Plus will work with most 
sound boards. If you need to purchase a different audio cable, contact your local 
computer hardware vendor. Be sure to identify the type of sound board you have 
and specify that you require an MPC-2 connector at the drive.
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18A. Secure the drive into the bay, using the screws included with your drive 
or any M3x0.5x6mm metric screw. (Do not use a screw longer than 6 
mm.)

If your computer uses rails or mounting brackets (see step 5) you may not 
need screws to secure the rails in the bay.

Use all four screws

2

3

4

1
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19A. Replace your computer's cover. 

20A. Plug your computer, monitor, and other devices into a wall outlet or 
power strip, and turn ON your computer. (The power plug and outlet 
may look different in your country. The U.S. version is shown.) 

Computer ON
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Replacing an Existing CD-ROM Drive With 
a CD-Writer Plus

Follow the instructions in this section if you will be removing a CD-ROM 
drive from your computer before installing the CD-Writer Plus.

Watching the Installation Video

1. Insert the CD labeled Software Disc 1 into your CD-ROM drive (not the 
CD-Writer Plus drive). The main menu appears:

If the main menu does not appear automatically, click on the Start 
button on the task bar, select Run, type D:\SETUP (where D: is your CD 
drive’s letter), then click on OK. 

If your computer does not have a CD-ROM drive, see page  A-1.
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2. Watch the installation video (about 4 minutes long). To do this, click on 
the Before You Install icon and then click on the Watch Installation 
Video icon. 

If you would like to, explore some of the other information options that 
appear on the screen.

Getting an Install Recommendation

CD-Writer Plus’ installation program will analyze your computer and tell 
you what jumper setting the CD-Writer Plus should use to work correctly 
on your computer. Jumper settings are explained on page 1-25. Getting 
this install recommendation is the first step in successfully installing 
your CD-Writer Plus.

1. Go back to the main menu and click on the Install CD-Writer Plus icon.

Follow the instructions on the screen. 

2. When the CD-Writer Plus Install Recommendation screen appears, click 
Print. Or, if you don’t have a printer, copy the information by hand. 
You’ll need this information in the next section.

Before You
Install icon

Watch Installation
Video icon

Install CD-Writer Plus icon
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Installing the Hardware

CAUTION: The discharge of static electricity can damage electronic circuitry. 
You can avoid static discharge by touching a grounded metal object such as 
your computer’s case before and during installation of hardware inside your 
computer or by wearing a grounding strap connected to ground.

1B. REMOVE the CD labeled Software Disc 1 from your CD-ROM 
drive.

2B. After getting the Install Recommendation (see the previous section) you 
will be prompted to shut down Windows. Click the Shutdown button 
and wait until it is safe to turn off your computer. Proceed to turn OFF 
your computer, monitor, and other devices. 

3B. Unplug the power cords from the wall outlet or from the power strip, if 
you use one. 

4B. Remove the cover from your computer.

CAUTION: Be careful of any sharp edges that may be present inside your 
computer.

See your computer’s 
manual if you need help
removing the cover.

Computer OFF
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5B. Remove the CD-ROM drive from your computer. To do this, remove all 
screws holding the CD-ROM drive in the bay and unplug all cables from 
the back of the CD-ROM drive. As you unplug them, lay the cables aside 
so they will be easy to find, since you will be plugging them into the CD-
Writer Plus drive later on. Then pull the drive out of the drive bay.

NOTE: You will not need to use the data cable that came with your CD-Writer 
Plus drive. If you already have an audio cable to connect the drive to the sound 
card, you will not need the one that came with the CD-Writer Plus.

6B. Look at the sides of the CD-ROM drive you removed. If it has rails or 
mounting brackets attached to the sides, remove them from the CD-
ROM drive and attach them to the CD-Writer Plus.
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7B. Write down the CD-Writer Plus’ serial number in the space below. The 
serial number is on the main label on the top of the drive.

8B. Read the Install Recommendation you printed earlier (see page 1-21). The 
Install Recommendation tells you whether the jumper on the CD-Writer 
Plus should be set as Master or Slave for your computer.

9B. Find the pairs of pins labeled Master, Slave, and Cable Select on the back 
of your CD-Writer Plus. Notice that one pair of pins has a small plastic 
cap or jumper. This jumper can be pulled off using your fingers, tweezers, 
or needlenose pliers, and placed on a different pair of pins to change the 
setting.

Serial 
number:

Drive’s serial number
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10B. Set the jumper on the CD-Writer Plus as advised in the Install 
Recommendation Printout for your computer. (see page 1-21)

or Master
Check the back of the new drive and 
make sure the jumper is on the right-
hand location (Master).

Don’t use
Cable Select

This is a jumper. You can pull
it off and place it on another
pair of pins to change the setting.

Slave
Check the back of the new drive and 
make sure the jumper is on the center 
location (Slave).
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11B. Insert your CD-Writer Plus into the drive bay previously occupied by 
your CD-ROM drive. 
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12B. The wide, flat cable that you previously unplugged from the CD-ROM 
drive is the data cable. Plug the data cable into CD-Writer Plus. Most 
connectors are keyed so that they only fit one way. If your connector is 
not keyed to fit only one way, make sure the cable’s colored edge is 
aligned with PIN-1, which is clearly marked on the CD-Writer Plus drive.

CAUTION: Make sure that you are attaching the cable correctly! You must 
locate PIN-1 on each connector and attach the cable so that the edge with the 
color stripe is aligned with PIN-1. If the cable is attached incorrectly, your 
computer may not boot up.

PIN-1
The cable’s colored edge is aligned 
with PIN-1 on the CD-Writer Plus 
drive.

Colored stripe on
the data cable



1-28 Replacing an Existing CD-ROM Drive With a CD-Writer Plus

13B. Plug the power cable into the back of the CD-Writer Plus, with the 
beveled edge up.

Beveled edge up
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14B. If you do not have a sound board or only want to 
listen to music discs using headphones or speakers 
attached to the front of the CD-Writer Plus, skip 
this step and go to step 15B.

You do not need an audio cable to record music. 
The audio cable is used only for listening to music 
CDs through your computer’s sound system. 
When the CD-Writer Plus drive records music or data, it uses the data 
cable, not the audio cable.

Using an existing audio cable

If your sound board already has a spare audio cable with an MPC-2 
connector (shown above), plug the MPC-2 connector it into the Audio 
Out opening on the back of the CD-Writer Plus drive.

Using the audio cable provided with your CD-Writer Plus

To use the audio cable that came with your CD-Writer Plus, first plug the 
end with only one connector to the Audio Out opening on the back of 
the CD-Writer Plus drive.

 

MPC-2 connector

Audio
cable
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Next, connect the other end of the audio cable to the sound board inside 
your computer.

Tips for connecting the audio cable to the sound board

■ Identify the sound board.

To identify the sound board look for microphone connectors on the back 
of your computer. The circuit board inside the computer attached to the 
microphone connectors is the sound board.

Sound board

The large connector or the small connector

sound board. Use only one connector.

“CD-IN” horizontal
connector

“CD-IN” vertical
connector

Audio
cable

may be the one that works for your
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■ Identify the audio connectors on the sound board.

The audio connectors have four prongs and are often on the outer edge 
of the sound board. On many sound boards the connectors for the audio 
cable are labeled CD IN.

■ Select the connector on the audio cable that fits your sound board.

The audio cable has two connectors in order to work with most sound 
boards. Try to match one of them to a connector on your sound board.

The audio cable may connect horizontally or vertically to the sound 
board. The connectors only fit one way. If a connector doesn’t fit, try 
turning it around. 

Use only one of the two connectors on this end of the audio cable. 
Simply leave the connector you don’t use unattached.

■ Some sound boards have more than one audio cable connector. If when 
you turn your computer back on you get no sound, try using a different 
connector on your sound board.

NOTE: The audio cable provided with CD-Writer Plus will work with most 
sound boards. If you need to purchase a different audio cable, contact your local 
computer hardware vendor. Be sure to identify the type of sound board you have 
and specify that you require an MPC-2 connector at the drive.
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15B. Secure the drive into the bay using the screws included with your drive or 
any M3x0.5x6mm metric screw. (Do not use a screw longer than 6 mm.) 

If your computer uses rails or mounting brackets (see step 6) you may not 
need screws to secure the rails in the bay.

Use all four screws

2

3

4

1
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16B. Replace your computer's cover. 

17B. Plug your computer, monitor, and other devices into a wall outlet or 
power strip and turn ON your computer. (The power plug and outlet may 
look different in your country. The U.S. version is shown.) 

18B. Go to page 1-34 for instructions on how to install the software.

Computer ON
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Installing Software: Windows 95, Windows 
98, or Windows NT 4.0

1. When you have turned your computer back on and it has started up, the 
CD-Writer Plus software will search for the new drive and make sure that 
it is communicating properly. You will be prompted to insert the CD 
labeled Software Disc 1 if it is not already in the drive.

2. Software installation will automatically continue. Follow the instructions 
on the screen to install the software you want.

Uninstalling the Software
You can remove all CD-Writer Plus programs or individual programs.

CAUTION: If you want to reinstall any software, be sure to uninstall the 
original program. 

To remove CD-Writer Plus programs:

1. Click the Start button.

■ Point to Programs

■ Point to HP CD-Writer Plus

■ Point to Tools & Information

■ Point to Utilities

■ Click Uninstall

2. Select the programs that you wish to remove.

3. Click the Finish button.

The software is removed, including all related entries in your system 
registry.
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If You Have Problems
Did you read the Install Recommendation? (see page 1-4 if you 
installed in an empty drive bay, or page 1-21 if you replaced a 
CD-ROM)

There are many factors that need to be taken into consideration when 
installing an IDE device. By reading the Install Recommendation, you 
will know how to install successfully without needing to evaluate the 
technical details.

Can’t find the IDE controller in your computer? 

Check the manual that came with your computer or call the computer 
manufacturer for assistance. The IDE controller may be located on the 
motherboard or a daughter board. It may be hard to find because it is 
behind some other component inside your computer such as the power 
supply. Or, your computer may not have a connector attached for access 
to the IDE controller. DO NOT ATTACH THE CD-WRITER PLUS DRIVE 
TO A SOUND BOARD’S IDE CONTROLLER. Do not use the Colorado IDE 
Adapter board as an alternate IDE controller for the CD-Writer Plus.

Now your computer won’t boot up! 

■ Turn your computer off and then back on.

■ Turn off and unplug your computer. Double-check each connector 
along the data cable and straighten any bent pins. The connectors are 
inserted properly when all pins are covered and the colored stripe on 
the side of the data cable lines up with PIN-1 of each connector.

■ Is the power cable attached correctly to each device?

■ If you are sharing the IDE data cable between the CD-Writer Plus 
drive and another device, did you change the data-cable (middle/end) 
connector attached to the device that was already inside your 
computer? Did you follow the Install Recommendation’s instructions 
for determining the jumper setting on page 1-4 (installation in an 
empty drive bay) or page 1-21 (CD-ROM replacement)?

If you changed the data-cable connector location, change it back to 
the original position. The other device may be jumpered to Cable-
select rather than Master or Slave. If this is true, the location of the 
data-cable connector (middle/end) is very important.
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The CD-Writer Plus drive doesn’t show up in My Computer or 
Explorer. 

■ If you cannot find the CD-Writer Plus drive in Explorer, restart your 
computer, or shut it down and then turn it on again.

■ Is the CD-Writer Plus drive receiving power? (Test this by opening and 
closing the tray by pressing the eject button on the front of the drive.)

■ Turn off and unplug your computer.

Double-check each connector along the data cable. The connectors 
are inserted properly when all pins are covered and the colored stripe 
on the side of the data cable lines up with PIN-1 of each connector.

■ If you are sharing the IDE data cable between the CD-Writer Plus 
drive and another device, did you change the data-cable (middle/end) 
connector attached to the device that was already inside your 
computer? Did you follow the Install Recommendation Printout’s 
instructions for the jumper setting on page 1-4 (installation in an 
empty drive bay) or page 1-21 (CD-ROM replacement)?

If you switched the data cable connector on the other device, change 
it back to the original position. A device attached to the end 
connector of the data cable to begin with, should be attached to the 
end connector after installing the new drive. If it was originally 
attached to the middle connector, it should remain attached to the 
middle connector. The other device may be jumpered to Cable-select 
rather than Master or Slave. If this is true, the location of the data-
cable connector (middle/end) is very important.

Not sure which drive letter was assigned to the CD-Writer 
Plus?

The CD-Writer Plus drive will have a drive icon just like a CD-ROM drive 
icon. You can determine which icon is your CD-ROM drive and which 
icon is your CD-Writer Plus drive by double-clicking on the My 
Computer icon, right-clicking on the CD drive’s icon, and selecting 
Eject. The tray of the selected drive will open.

The device that is sharing the IDE data cable with my CD-
Writer Plus drive doesn’t show up in Explorer or doesn’t work 
any more. 

■ Turn off and unplug your computer.

■ Make sure that the power cables are securely attached to both devices.
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■ If you are sharing the IDE data cable between the CD-Writer Plus 
drive and another device, did you change the data-cable (middle/end) 
connector attached to the device that was already inside your 
computer?

If yes, change the data-cable connector location back to the original 
position. The other device may be jumpered to Cable-select rather 
than Master or Slave. If this is true, the location of the data-cable 
connector (middle/end) is very important.

■ For Sony and Goldstar CD-ROMs, try configuring the CD-Writer Plus 
as Master and the CD-ROM as Slave.

Does your computer meet the minimum system requirements.

See Minimum System Requirements on page A-1. 

Error message when I double-click on the CD-Writer Plus icon.

■ There is no CD in the CD-Writer Plus drive. Insert a CD and try again.

■ After inserting a CD, you need to wait a moment to let the CD-Writer 
Plus drive read the disc information (wait until the light on the front 
of the drive stops flashing and stays green), then click on the CD-
Writer Plus drive’s icon again.

■ The CD may be in the tray upside-down or a little off-center; try 
reinserting the CD. The label should be facing up.

■ You are trying to read from a blank recordable CD. Try again after 
copying some information to the CD.

I already placed Software Disc 1 in the CD-Writer Plus but it 
continues to prompt me to insert the CD.

■ Make sure the jumper on the CD-Writer Plus is set as advised in the 
Install Recommendation Printout for your computer (see page 1-21 
and page 1-25).

■ Check the data cable and make sure the cable’s colored edge is aligned 
with PIN-1 on the CD-Writer Plus drive (see page 1-27).
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Chapter 2:
Using Your CD-Writer 
Plus

This chapter describes how to use, purchase, and care for CDs, how to 
take care of your drive, and how to find out its drive letter.

Using CDs

Inserting a CD

1. Press the eject button on the CD-Writer Plus front panel.

2. Set the CD in the tray with the labeled side up.

Eject button
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3. Press the eject button again or push gently on the front of the tray to 
shut the tray.

When you access the CD-Writer Plus drive from within a program, you 
should be able to read the files on the inserted CD. If you have problems: 

■ The CD may be in the tray upside-down or a little off-center; try 
reinserting the CD. The label should be facing up.

■ After inserting a CD, you need to wait a moment to let the CD-Writer 
Plus drive read the disc information (wait until the light on the front 
of the drive stops flashing and stays green), then click on the CD-
Writer Plus drive’s icon again.

■ Are you trying to read from a blank recordable CD? Try again after 
copying some information to the CD.

Removing a CD

1. Press the eject button on the CD-Writer Plus front panel.

2. Remove the CD from the tray.

3. Press the eject button again or push gently on the front of the tray to 
shut the front panel.

Choosing CDs for Your CD-Writer

For best results, use Hewlett-Packard CD-RW (ReWritable) or CD-R 
(Recordable or write-once) media, available from your local vendor.

When to Use CD-RW

Ideas for using CD-RW (ReWritable) discs which can only be used in CD-
ReWritable drives or newer MultiRead CD-ROMs:

■ Use as if it were a large-capacity floppy disk

■ Copy your important files each week

■ Free up disk space on your hard drive

■ Transport files to and from work/home

■ Hold large complex files as you develop them
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■ Create personalized presentations

■ E-mail storage

NOTE: MultiRead CD-ROMs may require a UDF reader to read CD-RW discs, 
depending on the application used to write them.

When to Use CD-RW

Ideas for using CD-R (Recordable or write-once) discs which can be read 
in most CD-ROM or CD-Recordable drives:

■ Permanently save large project files

■ Share non-editable presentations

■ Permanently store home records

■ Share memories with family and friends

■ Copy your music onto CD for personal use

■ Make copies of music you created for record company demos

■ Permanently archive files

Purchase HP CD-RW (ReWritable) media (C4404A)

Available from your local vendor, these CDs can be recorded or read in 
CD-ReWritable drives and read in newer MultiRead CD-ROMs.

Purchase HP CD-R (Recordable or write-once) media (C4403A)

Available from your local vendor, these CDs can be read by most CD-
ROM, CD-Recordable, and CD-ReWritable drives (use this type of media 
if you want to listen to your music CDs in a stereo).

CD Care and Other Tips

■ Protect recording surfaces from scratches, fingerprints, and dirt.

■ Hold CDs by the outer edge or by the center hole.

■ You can clean a CD with a soft, dry cloth. Commercial CD cleaner or 
ethyl alcohol can also be used

■ Write by hand only on the “white” premarked label side using an oil 
based felt tip marker. Do not use a ballpoint pen.

■ Do not leave a CD in direct sunlight or in a hot, humid location.
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■ If you ever lose power to the computer or have to press CTRL-ALT-
DEL while writing to a CD, do not open the CD tray. You may still be 
able to salvage your CD. For instructions on how to do this read the 
pertinent section on page 3-5.

■ Do not mix audio and data files on the same CD, since they require 
different formats, unless you are creating Mixed Mode or CD-Extra 
CDs. For more information on Mixed Mode and CD-Extra CDs see the 
Easy-CD Creator online help.

Maintenance
The CD-Writer Plus drive requires no maintenance or cleaning. If you 
simply keep your CDs clean, you will prevent most problems. 

CAUTION: DO NOT use the CD-ROM cleaning CDs that rely on a small brush 
to sweep dirt off the laser. DO NOT use high-pressure air to clean the inside of 
the drive. These cleaning techniques will damage the CD-Writer Plus drive.

Identifying CD-Writer Plus’s Drive Letter
Not sure which drive letter was assigned to the CD-Writer Plus 
drive?

The CD-Writer Plus drive will have a drive icon just like a CD-ROM drive 
icon. You can determine which icon is your CD-ROM drive and which 
icon is your CD-Writer Plus drive by double-clicking on the My 
Computer icon, right-clicking on the CD drive icon, and selecting Eject. 
The tray of the selected drive will open.



3-1

C
h

ap
ter 3:  P

ro
b

lem
 So

lvin
g

Chapter 3:
Problem Solving

Read this section if you run into trouble with your CD-Writer Plus drive. 
If after reviewing the section you need further assistance, call the phone 
numbers listed in ”Appendix B:  Customer Support”.

Gather the information on page B-1 before calling for assistance. Having 
this information ready will greatly facilitate your call.

Things to Try First
These are some basic steps to take when you run into trouble. If the 
problem persists, see the “Common Symptoms and Solutions” section.

■ Does your computer meet the minimum system requirements (see 
Minimum System Requirements on page A-1)?

■ Make sure the computer is plugged in and that each device has power.

■ Turn off the computer’s power, wait 20 seconds, then turn it on again. 

■ Try the operation with a different CD.

■ Make sure that you are using the right type of CD (See “Choosing CDs 
for Your CD-Writer” on page 2-2.)

■ Check the Readme file that came with the CD-Writer Plus drive. 

■ Check the free online information resources listed on page B-5.

■ If your computer has a power-management feature, disable it (see the 
manual that came with your computer).
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Common Symptoms
■ Now your computer won’t boot up! (see page 1-35)

■ Not sure which drive letter was assigned to the CD-Writer Plus? (see 
page 1-36)

■ The CD-Writer Plus drive doesn’t show up in My Computer or 
Explorer. (see page 1-36)

■ The device that is sharing the IDE data cable with my CD-Writer Plus 
drive doesn’t show up in Explorer or doesn’t work any more. (see page 
1-36)

■ The computer is trying to boot up from the CD-Writer Plus drive or 
receiving “Invalid Media” error message. (see page 3-3)

■ Copying directly from one CD to another doesn’t work. (see page 3-3)

■ Audio sounds poor. (see page 3-3)

■ Video is choppy. (see page 3-4)

■ Applications cannot locate the CD in the CD-Writer Plus drive. (see 
page 3-4)

■ Unable to see the CD label or all the sessions/files on the CD in 
Windows Explorer. (see page 3-5)

■ Lost power to the computer or had to press CTRL-ALT-DEL while 
writing to the CD! (see page 3-5)

■ Buffer underrun error messages. (see page 3-6)

■ Hard Drive compression software. (see page 3-6)

■ Achieving optimal performance. (see page 3-6)

■ Known compatibility problems. (see page 3-7)

■ Checking for resource conflicts. (see page 3-7)
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Solutions to Some Common Symptoms
The computer is trying to boot up from the CD-Writer Plus 
drive or receiving “Invalid Media” error message.

■ If the computer is trying to boot up the operating system from the 
CD-Writer Plus drive, simply remove the CD from the drive tray when 
starting up your computer.

■ If you do not want your computer to boot from the CD-Writer Plus 
drive, you need to change the “boot order” settings in your CMOS 
program. To learn how, see the documentation that came with your 
computer or call the computer manufacturer.

Copying directly from one CD to another doesn’t work.

WARNING: Only reproduce material for which you own the copyright or have 
obtained permission to copy from the copyright owner. Unless you own the 
copyright or have permission to copy from the copyright owner, you may be 
violating copyright law and be subject to payment of damages and other 
remedies. If you are uncertain about your rights, contact your legal advisor.

■ Some CD-ROMs will not allow direct copying to the CD-Writer Plus 
drive or are not capable of digital audio extraction.

■ You must have either a SCSI 2 CD-ROM drive (see the drive’s guide for 
information) or a supported ATAPI CD-ROM drive to use as your 
source.

■ Some CDs have a copy prevention feature or other features that do 
not allow a CD-to-CD copy.

Audio sounds poor.

■ Make sure the audio cable is completely plugged into the sound card 
and into the CD-Writer Plus drive.

■ Make sure that you do not have a sound-muting feature turned on 
through the monitor or in software.

■ Check the sound from the CD-Writer Plus drive by plugging 
earphones or speakers to the audio connector on the front of the CD-
Writer Plus drive. If the sound quality is good, the problem is 
probably with the sound board, speakers, or audio cable. See the 
documentation that came with your sound board and speakers for 
help. If you are not already doing so, try using the audio cable that 
came with the CD-Writer Plus drive.
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■ If you copied wave files from the hard drive to a CD, try listening to 
the wave files on your hard drive to see if they sounded poor before 
copying them to CD. (You can use the Media Player program found 
under Multimedia in Windows’ Accessories.)

Video is choppy.

This can result from the same situations that cause buffer underruns 
(explained on page 3-6) or can happen if your video card is slow. Try the 
following:

■ Try the solutions for buffer underruns (page 3-6).

■ Reduce the size of the video window and close any other programs 
that are running.

■ If the previous suggestions don’t work you may want to consider 
upgrading your video card.

Unable to see a second session reading from a CD-ROM drive.

■ Eject the CD and reinsert it.

■ Refresh the screen. To do this select the My Computer icon in 
Windows Explorer and press F5.

■ CD-RW (ReWritable) discs can only be used in CD-ReWritable drives 
or newer MultiRead CD-ROMs.

■ If you are trying to read your CD from Windows 3.x: Multi-session CDs 
created with Direct CD cannot be read in DOS or Windows 3.x. If 
your multi-session CD was created using some other program, verify 
that you are using version 2.23 of the MSCDEX.EXE file. First, restart 
your computer and when you see “Starting MS-DOS...” appear on 
your monitor, press F8. Each line in your CONFIG.SYS and 
AUTOEXEC.BAT file will load one at a time. Press “Y” until you see a 
line containing “MSCDEX.EXE”. Then press “Y” and the version 
number of your MSCDEX file will display. The number must be 2.23 
or greater. Call Microsoft for an updated file if you need it.

■ See if the CD-Writer Plus drive or other CD-ROM drives can read the 
CD. If so, the problem is probably with the CD-ROM drive. Contact 
the manufacturer of this drive for updated drivers. 

Applications cannot locate the CD in the CD-Writer Plus drive.

Some programs (CD-ROM games, etc.) look only for the first logical drive 
letter assigned to a CD-ROM drive or CD-Writer Plus drive. For example, 
if your CD-ROM drive is assigned drive D:\ and the CD-Writer Plus drive 
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is assigned drive E:\, the program is looking for the CD only in drive D:\ 
and will not see the CD in drive E:\. If you want to use the CD-Writer 
Plus drive with these programs, reassign the drive letters, making the CD-
Writer Plus drive come before the CD-ROM drive, as follows:

■ In Windows 95,click on Start/Settings/Control Panel and double-
click on the System icon. Display the Device Manager and double-
click on CDROM. Double-click on the CD-ROM drive, and then click 
on the Settings tab. Under Reserved drive letters, select the drive 
letter after the existing letter (for both start and end drive letter) and 
click on OK. Then double-click on the CD-Writer Plus drive, and then 
click on the Settings tab. Under Reserved drive letters, select the drive 
letter before the current one and click on OK.

■ In Windows NT, click on Start/Programs/Administrative 
Tools(common). Choose Disk Administrator. Right-click on the 
drive letter you wish to change. Select Assign Drive Letter. Change 
the drive letter.

Unable to see the CD label or all the sessions/files on the CD in 
Windows Explorer.

Refresh the screen. To do this select the My Computer icon in Windows 
Explorer and press F5.

Lost power to the computer or had to press CTRL-ALT-DEL 
while writing to the CD!

If you lose power while writing to your CD (the CD-Writer Plus drive's 
red light is on) OR if you exit an application or press CTRL-ALT-DEL 
while writing to CD...

You may be able to salvage your CD, but ONLY if you: 

1. LEAVE YOUR CD IN THE DRIVE, DO NOT OPEN THE CD TRAY
2. Turn your machine off
3. Turn it back on
4. Then re-enter the application you were using 

Once the application tries to access the CD-Writer Plus drive, the 
recovery operation will make it appear that the last session is there. 
However, in reality, only a part of the CD's directory may be there. Your 
recordable CD is still usable if you can read the directory. Repeat the 
entire copy operation to make sure that your files are copied to the 
recordable or ReWritable CD.
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Hard Drive compression software.

We do not recommend using hard drive compression software. If you use 
hard drive compression software, it estimates free hard drive space based 
upon a compression ratio (often user selectable). Programs may check 
your hard drive for space needed and may think you have the necessary 
free space. However, depending on the type of files you are copying, you 
may in fact not have enough hard drive space. 

Achieving optimal performance.

Run SCANDISK.EXE and DEFRAG.EXE on your hard drive before using 
your CD-Writer Plus drive for the first time (see your Windows manual 
for more information). Then run them periodically after that. These 
programs improve access times to the hard drive, which will help 
improve system performance while writing to and reading from the CD-
Writer Plus drive.

Buffer underrun error messages.

CD recordable devices require an uninterrupted data stream from the 
hard drive in order to write successfully to a CD. A buffer underrun 
message appears when for some reason the data stream is interrupted. 
This can occur, for example, if another application interrupts the writing 
process, or if the CD-Writer Plus drive’s write speed is set too high for the 
speed at which the hard drive can accesses and transfer data.

When using Easy-CD Creator or Disc Copier:

■ Make sure you use the Test option in the software to ensure that the 
write speed is appropriate for your computer. For more information 
see the application’s online help.

■ Make sure your system meets the minimum system requirements, see 
Minimum System Requirements on page A-1.

■ Buffer underrun may be caused by hard drive compression software 
(see page 3-6). 

■ NEVER write to the recordable CD while other applications are 
running that could interrupt the writing-to-CD process. Log off any 
networks, disable any fax modem, email, screen saver, or other 
programs (such as TSRs, terminate-and-stay-resident programs) that 
may automatically send messages to your computer while writing 
data to the CD. If the interruption is long enough, you could ruin a 
write-once CD to which you are writing.

■ Exit any other programs before writing data to the CD.
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■ If your computer has a power-management feature, disable it (see the 
manual that came with your computer).

■ Run SCANDISK.EXE and DEFRAG.EXE periodically on your hard 
drive (see your Windows manual for more information). These 
programs improve access times to the hard drive, which will help 
improve system performance while writing to and reading from the 
CD-Writer Plus drive.

■ A small number of older hard drives are designed with a built-in 
interrupt loop that may cause a buffer underrun. If you are unable to 
resolve buffer underruns by any other means, contact your hard drive 
manufacturer to find out if this is the case for your hard drive.

Known compatibility problems.

■ Check the Readme file that came with the CD-Writer Plus drive for 
additional information.

■ Check the web site listed on page B-5 for the most recent information.

Checking for resource conflicts.

In rare cases, your computer’s IDE controller may be having a resource 
conflict where another device is trying to use the IDE controller’s I/O 
base address or interrupt request channel (IRQ). To check for this type of 
conflict:

■ In Windows 95, right-click on the My Computer icon, select 
Properties, select the Device Manager tab, and double-click on CD-
ROM, if the list is not already expanded. A yellow exclamation mark 
over the controller’s icon confirms that the controller has the same or 
conflicting settings as another device installed on your system. 
Resolve this conflict by assigning a unique IRQ and I/O base address 
to the other device.

■ In Windows NT, if this type of conflict is present, you will see an error 
message when you start up Windows NT. Follow the directions in the 
error message box.
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Chapter 4:
Sharing Your CDs

How you write your data to CD and the type of CDs that you use will 
determine who else can read the data from your discs. This chapter 
briefly explains some of the options you have in creating CDs that can be 
shared with others using different computer and CD setups.

Varying Formats
CD technology has progressed rapidly over the last few years from CD-
ROM to writable CD, and on to the technology you now own in your 
rewritable CD-Writer Plus. One of the results of these developments is 
that data can be written in several formats and on different types of CDs. 

Sharing CDs across Different Formats

Using CD-RW Discs

When should I use CD-RW discs?

CD-RW media is the ideal solution if you need more storage space on 
your computer. Your CD-Writer Plus drive, coupled with CD-RW media, 
can function as an extension of your hard drive.You can write, erase, and 
rewrite data easily from applications and from the Windows Explorer. 
Use CD-RW media:

■ To save work in progress like presentations, documents, etc.

■ Make weekly archives of files on your hard drive.

■ Shuttle files between the office and home if you have a CD-Writer 
Plus at each location, or have an external CD-Writer Plus to use on 
both computers.
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Can I share a CD-RW disc?

Yes. You can share a CD-RW disc directly with someone owning another 
CD-RW drive or with someone that has a MultiRead CD-ROM drive and 
UDF reader software. MultiRead CD-ROM drives are a recent innovation 
to CD-ROM technology, so while not all CD-ROMs are MultiRead, they 
are available to users world wide.

How do I know if a CD-ROM is MultiRead?

Look for the MultiRead certification logo on the CD-ROM’s packaging or 
users guide. The drive will be described as MultiRead certified or will list 
CD-RW as supported media. You can also put a CD-RW disc in your CD-
ROM and see if it can read it. 

What if I want to share with users that have standard CD-ROM 
drives? (In Windows 95, Windows 98, and Windows NT 4.0)

In general, you must copy your information to a CD-R disc to share it 
with users that have standard CD-ROM drives. To accomplish this: 

1. Insert your CD-RW disc in your CD-Writer Plus drive. 

2. Copy all the information from the CD-RW disc to a unique location on 
your hard drive.

3. Replace the CD-RW disc in your CD-Writer Plus with a blank CD-R disc.

4. Copy the information from your hard drive to the CD-R media using 
DirectCD.

5. When you eject the disc, DirectCD prompts you to either leave the disc 
as it is, or organize the disc so it can be read in most standard CD-ROM 
drives. Select the option to organize the CD so it can be read in most 
standard CD-ROM drives.

 NOTE: For additional information on sharing CDs with Windows 3.x and 
DOS users, see “CD-R discs created with DirectCD.” on page 4-3.

Can I play an audio disc I made on a CD-RW disc in my car or 
home CD player?

Probably not. Most car and home CD players are not capable of reading 
information off of CD-RW media. You must record your audio on CD-R 
discs to play them on most conventional CD players. There are however 
some newly released auto and home CD players that can read the CD-RW 
media.
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Using CD-R Discs

When should I use CD-R discs?

The data you put on a CD-R can’t be erased. Use CD-R discs:

■ When you want to protect your data so that it cannot be erased

■ If you want to share your CD with users that have standard CD-ROM 
drives

■ For audio CDs

Can I automatically share a CD-R with anyone?

Not necessarily. The software application you use will determine with 
whom you can easily share the CD.

CD-R discs created with DirectCD.

Use DirectCD when you want to create data CDs to use on your own 
computer. For instructions on how to use DirectCD go to “Making Data 
CDs to Use on Your Own Computer” on page 5-1.

When you eject the disc from the drive, DirectCD will prompt you to 
either leave the disc as it is so you can add more data later, or organize it 
so it can be read in most standard CD-ROM drives under Windows 95 or 
Windows NT 4.0 Service Pack 3. If you intend to share the disc with other 
users, then you must select the option to organize it so it can be read in 
most standard CD-ROMs.

■ Windows 95, Windows 98, and Windows NT 4.0. Your CD-R 
organized to be read in most standard CD-ROMs is now ready to be 
shared with Windows 95, Windows 98, and Windows NT 4.0 users.

There may be some CD-ROMs that can’t read the CD-R. If you have 
problems try turning off the “Read Ahead” on your CD-ROM. Refer to 
your operating system documentation on how to do this. Another 
option is to use CD Copier to create a disc copy of your original CD-R 
disc. A description of how to do this can be found in the section 
“Making a Copy of a CD” on page 8-3.

■ Windows 3.x and DOS. Your CD-R organized to be read in most 
standard CD-ROMs under Windows 95 and Windows NT cannot 
automatically be read in Windows 3.x or DOS. Some additional steps 
are required if you want to share this disc with Windows 3.x or DOS 
users. You will need to create a copy of your original CD-R disc on 
another piece of CD-R media using the CD Copier application. This 
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will write a disc in the proper format for Windows 3.x and DOS users. 
Follow the instructions given in the section “Making a Copy of a CD” 
on page 8-3 to accomplish this task.

NOTE: CDs created with CD Copier will display long filenames when viewed in 
Windows 95, 98, and NT. When viewed in Windows 3.x and DOS, file names 
are shortened to the DOS standard of eight characters with a three-character 
extension. Files and executables that expect a specific file name may not 
function as anticipated in Windows 3.x and DOS.

CD-R discs created with Easy-CD Creator (Audio). 

This application automatically writes the audio format understood by 
millions of car and home CD players in existence today. You will be able 
to share this disc with virtually any user. 

CD-R discs created with Easy-CD Creator (Data).

Use Easy-CD Creator (Data) when you want to create data CDs you can 
share with other users, for example if you want to send the CD to your 
co-workers. For instructions on how to use Easy-CD Creator (Data) go to 
“Making Data CDs to Use on Different Types of Computers” on page 5-6

Easy-CD Creator is called a mastering application since, when used with 
CD-R media, it is capable of directly writing discs using a format that can 
be read by virtually all CD-ROM drives and operating systems 
(Windows95, Windows NT, Windows 3.x, and DOS). 

Interchange Summary

The following table is a brief summary of which CD drives can read discs 
created with certain application/media combinations.

Application 
used to make 

a CD

Type of CD 
used

Drives that can read the CD

DirectCD CD-RW MultiRead CD-ROM with UDF 
reader
Windows 95, 98, and NT 4.0

CD-R
(closed)

*Most CD-ROMs 
Windows 95, 98, and NT 4.0

CD Copier CD-RW MultiRead CD-ROM

CD-R Any CD-ROM 
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* Your CD-ROM drive must be capable of reading packet-written CDs. Most CD-ROM drives 
are packet tolerant. If you have problems, check your drive’s documentation or consult the 
drive’s manufacturer.

Easy-CD 
Creator
(Audio)

CD-RW MultiRead CD-ROM

CD-R Any CD-ROM, home or car CD 
player

Easy-CD 
Creator
(Data)

CD-RW MultiRead CD-ROM

CD-R Any CD-ROM

Application 
used to make 

a CD

Type of CD 
used

Drives that can read the CD
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Chapter 5:
Making Data CDs

You can make data CDs with DirectCD™ and with Easy CD Creator™. You 
can copy data to both CD-Recordable (CD-R) and CD-ReWritable 
(CD-RW) discs. DirectCD and Easy CD Creator make data CDs in a 
slightly different way for different purposes. The correct program is 
launched automatically when you decide what kind of data CD you want 
to make.

■ If you want to make a data CD to use on your own computer, follow 
the instructions in “Making Data CDs to Use on Your Own 
Computer” below.

■ If you want to make a data CD to use on your own computer or on 
different types of computers (for example, computers running under 
DOS or Windows 3.x) that do not have DirectCD, follow the 
instructions in “Making Data CDs to Use on Different Types of 
Computers” on page 5-6.

Making Data CDs to Use on Your Own 
Computer

DirectCD enables you to write files directly to a CD-Recordable (CD-R) or 
CD-ReWritable (CD-RW) disc, in much the same way you would write 
them to a floppy diskette or a removable media drive. This is especially 
handy for making data discs to use with your own computer. For 
example, you might want to

■ Archive data and then remove it from your hard drive

■ Back up the files on your hard drive
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■ Transfer a large number of files from the computer you use at work to 
the computer you use at home

NOTE: Other people may be able to read data discs you create with DirectCD 
on their computers if their CD-related hardware and software is set up the same 
as it is on your computer. However, it is more likely that your data discs will be 
usable on other computers if you create them with Easy CD Creator, as 
described in “Making Data CDs to Use on Different Types of Computers” on 
page 5-6.

DirectCD lets you read and write files directly to your CD with any 
software application that can read from and write to a drive letter. Some 
examples include:

■ Software applications such as Microsoft Word, when you use the 
Save or Save As commands

■ Windows Explorer, when you drag and drop files

■ Windows 95®/NT, when you use the Send To command

■ MS-DOS, when you use command prompts from within 
Windows 95/NT

DirectCD provides a file system based on UDF v1.5 specifications and 
writes data to the CD-R or CD-RW disc using packet-writing technology. 
This technology, together with the file system, gives you drive letter 
access to your CD-Writer Plus. A DirectCD wizard guides you step-by-step 
through the process of preparing and ejecting CD-R and CD-RW discs.

Preparing a Data CD

Follow these steps to start DirectCD and prepare a blank CD-R or CD-RW 
disc for reading and writing data. (If you want to write more data to a 
disc that you already formatted in DirectCD, see “Writing More Data to a 
DirectCD Disc” on page 5-5.)

1. Start up your computer.

2. Insert a blank CD-R or CD-RW disc in the CD-Writer Plus. After a few 
seconds a screen will appear which asks you to “Please select the type of 
CD you wish to create.” (If the DirectCD Disc Ready window appears, the 
disc has already been prepared, and you can start writing data to it.)
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NOTE: If no screen appears after about 15 seconds, the disc may not be blank, 
or it may have an unreadable format. (See “Fixing an Unreadable Disc” on 
page 5-6 for more information.) Or the “Auto insert notification” option may be 
disabled (this applies to Windows 95 only). To check this, click Start, move the 
mouse pointer over Settings, and click Control Panel. In Control Panel, 
double-click System and select the Device Manager tab. Double-click the 
CD-Writer Plus icon, then select the Settings tab. Click Auto insert 
notification if it does not have a check mark next to it, and click OK. Click 
OK on the System Properties dialog box. Then close the Control Panel.

3. Select the first option: Click here to create a data CD that will be 
accessible through a drive letter, i.e. as you would use a floppy drive. 
The Format Disc screen appears. If you are formatting a CD-R disc, 
continue with the next step. If you are formatting a CD-RW disc, skip to 
step #5.

4. If you are formatting a CD-R disc, click Next on the Format Disc screen 
and skip to step #6.

5. If you are formatting a CD-RW disc, you can choose between two 
formatting options. To do this, click the Advanced button that appears 
on the Format Disc screen. When the next screen appears, select either 
Fast Format or Full Format and click OK.

We recommend that you select HP fast format, which lets you start 
writing to the CD-RW disc almost immediately while the disc is 
formatted in the background. A Full Format requires you to wait about 
an hour until the formatting is complete before you can write to the disc. 
Click the Help button for more information about the formatting 
options.

NOTE: Data is safe if you write it to the disc while HP fast format takes place 
in the background. HP fast format will NOT overwrite this data, because the 
data is written to sections of the disc that have already been formatted.

6. When the Name Your Disc screen appears, type a name for the disc and 
click Finish. Disc formatting begins.

When the DirectCD Disc Ready window appears, the formatting is 
complete.

NOTE: Formatted CD-RW discs have about 530 MB of available space, while 
formatted CD-R discs can store up to 618 MB of data.

7. Click OK.

The DirectCD disc is ready for you to write data to it.
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Writing Data to a DirectCD Disc

Once your CD is formatted as a DirectCD disc, you can write data to it in 
several different ways:

■ Drag and drop files from Windows Explorer onto the CD-Writer Plus 
icon.

■ Select Save As from a Windows 95/NT application File menu and 
select the drive letter of your CD-Writer Plus.

■ Use the Send To command.

■ Use MS-DOS command prompts from a DOS window in 
Windows 95/NT.

Ejecting a DirectCD Disc

DirectCD gives you various formatting options when you eject a 
DirectCD disc from the CD-Writer Plus. The options depend on what 
kind of disc DirectCD detects in the drive and how you want to use the 
disc. To eject a DirectCD disc, follow these steps:

1. Push the eject button on the front of the CD-Writer Plus, or

Right-click on the CD icon  on the taskbar and select Eject from the 
drop-down list box.

The Eject Disc screen appears.

2. Carefully read the text that appears on the screen and, if options are 
presented, select the option you want.

3. Click Finish to eject the disc from the CD-Writer Plus.

NOTE: If you are using a CD-RW disc, see “Chapter 4: Sharing Your CDs” for 
more information about making CDs readable on different types of computers.
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Writing More Data to a DirectCD Disc

If you previously formatted a blank disc for DirectCD use, you can add 
more data to the disc until it is full. To do so, follow these steps:

1. Insert the DirectCD disc into your CD-Writer Plus.

2. Wait for the DirectCD Disc Ready window to appear. (If the Make Disc 
Writable screen appears, simply follow the on-screen directions to make 
the disc writable.)

3. Click OK and continue writing more data to the disc.

Erasing a DirectCD Disc

If you are using CD-RW discs in your CD-Writer Plus, you can actually 
erase files from the disc and use the recovered space to write new files. 
However, if you “delete” files from a CD-R disc, the files become invisible 
to the file system (such as Windows Explorer) but the space they occupy 
is not made available for other files. Thus, “deleting” files from a CD-R 
disc will not increase the available free space on the disc.

To erase the contents on a DirectCD disc, follow these steps:

1. While in Windows Explorer, select the file(s) you want to erase.

2. Select Delete from the File menu.

3. Click Yes to confirm that you want to erase the files from the disc.

DirectCD erases the selected file(s) from the disc.
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Fixing an Unreadable Disc

If no window appears on the screen after about 15 seconds when you 
insert a disc in the CD-Writer Plus, the disc may have an unreadable 
format. DirectCD has a ScanDisc application that may be able to recover 
data on the disc and allow you to write to it and read from it again. 
Follow these steps to use ScanDisc:

1. Double-click the CD icon on the right side of the Windows taskbar. 
If the disc is unreadable, the ScanDisc window will appear.

2. Read the text in the window, then click the ScanDisc button.

3. Wait while ScanDisc repairs the disc. A message will appear on the screen 
when ScanDisc is finished.

NOTE: You can also start ScanDisc through the Start menu. To do this, click 
Start on the Windows taskbar. Move the mouse pointer over Programs, HP 
CD-Writer Plus, Tools and Information, and Utilities. Then select ScanDisc.

Making Data CDs to Use on Different 
Types of Computers

Adaptec Easy CD Creator enables you to write files directly to a 
CD-Recordable (CD-R) or CD-ReWritable* (CD-RW) disc in a format that 
can be read by different types of computers. This is handy if, for example, 
you want to create a CD for someone who has a computer running under 
DOS or Windows 3.x.

Follow these steps to start Easy CD Creator and copy data files to a blank 
CD-R or CD-RW disc:

1. Start up your computer.

2. Insert a blank CD-R or CD-RW disc in the CD-Writer Plus. After a few 
seconds a screen will appear which asks you to “Please select the type of 
CD you wish to create.”

* CD-RW discs can only be read in a MultiRead CD-ROM drive or in another 
CD-RW drive.
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NOTE: If the screen does not appear after about 15 seconds, you may have 
inserted a disc that is already formatted. Remove the disc and insert a blank 
disc. Or the “Auto insert notification” option may be disabled (this applies to 
Windows 95 only). To check this, click Start, move the mouse pointer over 
Settings, and click Control Panel. In Control Panel, double-click System and 
select the Device Manager tab. Double-click the icon for the CD-Writer Plus, 
then select the Settings tab. Click Auto insert notification if it does not have 
a check mark next to it, and click OK. Click OK on the System Properties dialog 
box. Then close the Control Panel.

3. Select the second option: Click here to create a data CD for 
distribution among different types of computers. The Easy CD Creator 
Wizard appears.

4. Leave the Data CD radio button selected, and click Next.

5. When the next screen appears, select the files and folders you want to 
copy to the disc and click Add Now. The graph bar in the lower part of 
the screen indicates how much space is left on the disc.

6. When you are done adding files, click Next. The Test Before Writing 
window appears.

7. Click Next, then click Finish on the Ready to Create CD window to 
create the CD. The testing and copying process may take a long time if 
you are copying many folders and files.

8. When the testing and copying process is completed, eject the CD from 
the drive.

NOTE: These instructions describe the simplest, most direct way to create a 
data disc with Easy CD Creator. Other options are also available, such as re-
arranging the folder/file structure after you have selected the files to copy to the 
CD. See the Easy CD Creator online help for more information.
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Getting Help
For setup and connection problems with your CD-Writer Plus, refer to 
the Troubleshooting section of the user’s guide.

For information about Easy CD Creator and DirectCD, refer to the 
appropriate topics in the online Help. To access the online Help, select 
Help Topics from the Help menu of either program.

Technical information, including product literature, answers to 
commonly asked questions, information on software upgrades and other 
topics is available electronically through the following:

■ Adaptec World Wide Web (WWW) site at http://www.adaptec.com.

■ The Adaptec Software Products Group can be found on several 
CD-ROM, CD-R, and CD publishing newsgroups and lists on the 
Internet.

For customer support information, refer to Appendix B, “Customer 
Support.”
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Chapter 6:
Making Music CDs

A music CD is a compact disc (CD) containing digital audio tracks 
recorded in the Compact Disc-Digital Audio (CD-DA) format.

Music CDs can store up to 74 minutes of music and may contain up to 99 
tracks, each usually representing a separate piece of music. Music CDs 
can be played back from a home or car CD player or from a CD-ROM 
drive through speakers or headphones attached to the drive’s output jack.

You can use Easy CD Creator to:

■ Compile audio CDs of your favorite music

■ Make CDs from Wave (.wav) files on your hard drive

Starting Easy CD Creator
1. Start up your computer.

2. Insert a blank CD-R or CD-RW disc in the CD-Writer Plus. After a few 
seconds a screen will appear which asks you to “Please select the type of 
CD you wish to create.”

NOTE: If no screen appears after about 15 seconds, you may have inserted a 
disc that is already formatted. Remove the disc and insert a blank disc. Or the 
“Auto insert notification” option may be disabled (this applies to Windows 95 
only). To check this, click Start, move the mouse pointer over Settings, and 
click Control Panel. In Control Panel, double-click System and select the 
Device Manager tab. Double-click the icon for the CD-Writer Plus, then select 
the Settings tab. Click Auto insert notification if it does not have a check 
mark next to it, and click OK. Click OK on the System Properties dialog box. 
Then close the Control Panel.
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3. Select the third option: Click here to create an audio CD that will be 
playable in any CD player. The Adaptec Easy CD Creator Wizard 
window appears.

Making a Music CD
You can make a music CD by recording songs from:

■ Tracks on an existing CD

■ Wave files stored on your hard drive (*.wav is a standard Windows 
format for sound files.)

■ A combination of Wave files and tracks

This section explains how you can make a simple music CD with the 
Easy CD Creator Wizard. It also explains how to do other tasks like 
recording audio tracks from an existing music CD and recording Wave 
files stored on your hard drive.

NOTE: Easy CD Creator is designed to assist you in reproducing material in 
which you own the copyright or have obtained permission to copy from the 
copyright owner. Unless you own the copyright or have permission to copy from 
the copyright owner, you may be violating copyright law and be subject to 
payment of damages and other remedies. If you are uncertain about your rights, 
contact your legal advisor.
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Using the Wizard

The easiest way to make a music CD is to use the Easy CD Creator 
Wizard, which appears when you first start Easy CD Creator. The Wizard 
guides you step-by-step in making a simple music CD. Follow these steps 
to make a music CD with the Wizard:

1. Start Easy CD Creator if it is not already running (see “Starting 
Easy CD Creator” on page 6-1.) The Adaptec Easy CD Creator Wizard 
appears, as shown here:

2. Follow the on-screen instructions in the Wizard windows.

As you add tracks to write to the CD, a list of these tracks will appear in 
the main Easy CD Creator window at the bottom of the screen. A final 
message box notifies you when the recording is complete.

Recording Audio Tracks from an Existing 
Music CD

To record songs (audio tracks) from an existing music CD, you need to 
first create a CD layout— a file that contains the list of songs and the 
order in which they will be recorded—then record the layout to a blank 
CD. To do so, follow these steps:

1. Start Easy CD Creator, if it is not already running.
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2. Select New CD Layout from the File menu or open an existing CD 
layout. 

3. Click the Audio CD Layout tab:

The top part of the window is Windows Explorer, where you can select 
the songs you want to record. The bottom part is the Audio CD Layout 
window, which allows you to view the contents of the CD layout. To 
make changes to the list of tracks in the Audio CD Layout tab, see 
“Changing the Order of Your Songs” on page 6-8.

4. Insert the source CD, which contains the songs you want to record, in 
your CD-Writer Plus.

NOTE: You can record directly from a CD-ROM drive only if it supports digital 
audio extraction. See “Recording from a CD-ROM Drive” in the 
Easy CD Creator Online Help.

5. In the Windows Explorer section of the window, select the drive where 
the source CD is located to view the list of songs on the original CD.

6. Drag the songs that you want to record from Windows Explorer to the 
Audio CD Layout window. 

To change the name of a song, see “Renaming Songs in Your CD Layout” 
on page 6-8.

Windows Explorer Audio CD Layout Window
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7. Repeat steps 4, 5, and 6 for each existing music CD from which you want 
to record songs. 

8. Select Create CD from the File menu when you have placed all of the 
songs that you want to record into the Audio CD Layout window.

The CD Creation Setup box appears.

9. Make changes, if any, to the CD Creation Setup settings (see “CD 
Creation Setup Settings” in the Easy CD Creator Online Help for 
descriptions) and click OK.

Easy CD Creator needs a blank CD before it can begin recording your CD 
layout. Insert a blank CD when prompted. A final message box notifies 
you when the recording is complete.

NOTE: To make a jewel case insert that lists the artist, CD title, and songs, see 
“Chapter 7: Making Inserts and Labels”.

Recording Wave Files Stored on Your Hard 
Drive

To record a music CD using Wave files (*.wav), the Wave files must be 
stored on your hard drive at 11, 22, 44.1 KHz, 8- or 16-bit, mono or 
stereo. To make a Wave file from an existing CD, see “Pre-recording 
Audio Tracks to Wave Files” on page 6-6.

NOTE: For best results, record your .wav files at 44.1 KHz, 16-bit stereo. For 
more information, see the documentation for your Wave editor program.

To record Wave files stored on your hard drive to a blank CD, follow 
these steps:

1. Insert a blank CD in your CD-Writer Plus.

2. Select New CD Layout from the File menu, or open an existing layout.

3. Click the Audio CD Layout tab.

4. Select the Wave files you want to record from Explorer and drag them to 
the Audio CD Layout window.

5. To change the name of the song(s), see “Renaming Songs in Your CD 
Layout” on page 6-8.
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6. Select Create CD from the File menu when you have finished adding all 
of the songs you want to record to your CD layout. The CD Creation 
Setup box appears.

7. Make changes, if any, to the CD Creation Setup settings (see “CD 
Creation Setup Settings” in the Easy CD Creator Online Help for 
descriptions) and click OK.

Easy CD Creator will begin recording your CD layout to the blank CD. 
An on-screen message notifies you when the recording is complete.

NOTE: To make a jewel case insert that lists the artist, CD title, and songs, see 
“Chapter 7: Making Inserts and Labels.”

Pre-recording Audio Tracks to Wave Files

Pre-recording audio tracks to Wave files on your hard drive is a way to:

■ Minimize swapping CDs in and out of your drive if you want to make 
more than one copy, or if you have only a CD-Writer Plus drive

■ Add sound effects to customize any song on the CD (using a third-
party sound editor)

■ Improve the sound quality if your CD recording system is less than 
optimal

You can pre-record one Wave file at a time. To pre-record a Wave file from 
an existing CD, follow these steps:

1. Insert the source CD, which contains the song you want to pre-record to 
your hard drive, into your CD-Writer Plus.

2. Click the Audio CD Layout tab in Easy CD Creator.

3. Select the audio track you want to pre-record from Explorer and drag it 
into the Audio CD Layout window.

4. Highlight the audio track in the Audio CD Layout window.

5. Select Pre-record to WAV file from the Track menu.

NOTE: Pre-recording audio tracks to Wave files requires approximately 10MB 
of space on your hard drive for one minute of music.
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6. Type in a file name for the Wave file and choose a different location on 
your hard drive if you do not want to record your Wave file to your Temp 
directory.

7. Click Save.

Easy CD Creator pre-records your Wave file to your hard drive. An on-
screen message notifies you when the recording is complete.

Combining Both Audio Tracks and Wave Files

You can make a music CD that contains songs both from pre-recorded 
Wave files stored on your hard drive and from audio tracks on an existing 
music CD. To do so, follow the steps outlined in “Recording Audio Tracks 
from an Existing Music CD” on page 6-3 and “Recording Wave Files 
Stored on Your Hard Drive” on page 6-5, depending on the type of songs 
you want to record. When you have added all of the audio tracks and 
Wave files you want to record to your CD layout, select Create CD from 
the File menu.
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Modifying Your CD Layout
The following sections describe how to make changes to your CD layout.

Changing the Order of Your Songs

Once you have added more than one song to your CD layout, you can 
change the order of the songs at any time before creating the CD.

To change the order of the songs, follow these steps:

1. Select the song whose order you want to change in the CD layout.

2. Drag the song to the position where you want it to appear in the Audio 
CD Layout window.

Removing Songs from Your CD Layout

You can remove any song you have added to a CD layout at any time 
before you create a CD. To remove a song from your CD layout, follow 
these steps:

1. Select the song you want to remove in the Audio CD Layout window.

2. Select Cut from the Edit menu.

Renaming Songs in Your CD Layout

To rename a song listed in your CD Layout, follow these steps:

1. Select the song you want to rename in the Audio CD Layout window.

2. Select Rename in the Track menu.

3. Type the new name in the text box.
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Saving a CD Layout

You can create a CD layout, save it, then use it to record a CD later. To 
save a CD layout, follow these steps:

1. Select Save As from the File menu.

2. Type in the File name.

3. Select the location where you want to store the file.

Opening an Existing CD Layout

To open a CD layout you have previously saved:

■ Select Open CD Layout from the File menu. 

Easy CD Creator displays the contents of the layout.

Playing Music CDs
Use the Windows CD Player to listen to music CDs. To do this, follow 
these steps:

1. Insert the music CD in your computer’s CD-ROM drive.

2. Click the Start button on the Windows taskbar, then move the mouse 
pointer over Programs, Accessories, and Multimedia.

3. Select CD Player. The CD Player window appears.

4. Click the start button to start playing the music CD.
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Getting Help
For setup and connection problems with your CD-Writer Plus, refer to 
the Troubleshooting section of the user’s guide.

For information about Easy CD Creator, refer to the appropriate topics in 
the online Help. To access the Easy CD Creator online Help, select Help 
Topics from the Help menu.

Technical information, including product literature, answers to 
commonly asked questions, information on software upgrades and other 
topics is available electronically through the following:

■ Adaptec World Wide Web (WWW) site at http://www.adaptec.com.

■ The Adaptec Software Products Group can be found on several 
CD-ROM, CD-R, and CD publishing newsgroups and lists on the 
Internet.

For customer support information, refer to Appendix B, “Customer 
Support.”



7-1

C
h

ap
ter 7:  M

akin
g

 In
serts 

an
d

 Lab
els

Chapter 7:
Making Inserts and 
Labels

A jewel case insert is a cover you can print and insert in the CD’s jewel 
case—the plastic case that holds the CD—to display the title and contents 
of your CD.

The cover is printed on one side of a sheet of paper and then folded. One 
side lists the files or tracks; the other side shows the title and may also 
contain graphics.

Easy CD Creator allows you to customize your own jewel case insert. 
Once you have edited the jewel case insert, you can preview it, print it, 
cut it to size, and insert it in the case. You can also design and print a 
label for the top of the CD. You can print the label on a standard printer 
if you use special paper designed for disc labels.
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How to Make a Jewel Case Insert or a Label
When you make a music CD, Easy CD Creator uses the CD layout 
information to create a basic jewel case insert, including the CD title, 
artist name, and list of songs. You can then click the Jewel Case Layout 
tab to modify and customize that information, such as changing font 
styles and adding graphics. 

Creating custom jewel case inserts involves three basic tasks:

■ Editing inserts

■ Adding text and graphics

■ Printing

Creating CD labels involves the second and third steps; Easy CD Creator 
does not automatically create any text for the label. The following 
sections explain how to view and edit jewel case inserts and CD labels, 
add text and graphics, and print the inserts and labels.

Editing Inserts and Labels

The following sections describe the different ways you can view and edit 
jewel case inserts and labels before printing them.

Viewing Inserts and Labels

To view the different parts (pages) of the jewel case insert or CD label, 
follow these steps:

1. Click the Jewel Case Layout tab in Easy CD Creator.

2. From the Page menu, select the item you want to view:

■ Jewel Front—to view the Inside Jacket and Front Cover

■ Jewel Back—to view the Back Cover

■ Disc Printer—to view the Compact Disc label

Easy CD Creator displays the view.
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Zooming

To view a section of an insert page or label in greater detail, you can 
magnify the view. To change the magnification of the page, follow these 
steps:

1. Select Zoom from the Page menu.

2. Select the zoom level you want to apply.

3. Click OK.

Easy CD Creator changes the magnification level.

Using Rulers and Grids

You can use rulers and grids to position text and graphics on the jewel 
case insert or the label. See “Setting Insert Layout Options” in the 
Easy CD Creator online Help for more information on how to do this.

Using Rulers

Rulers are displayed along the perimeter of the Jewel Case Layout 
window and help you to measure the insert or label and its objects.

To display or hide the rulers, do the following:

■ Select the Ruler option from the View menu to view rulers.

■ Deselect the Ruler option from the View menu to hide rulers.
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Using Grids

Grids help you to more precisely position objects with respect to other 
objects on the insert or label.

To snap objects to a grid—meaning the objects are automatically moved 
to the grid line—do the following:

1. Select Grid from the Layout menu.

2. Select Snap to Grid from the Layout menu.

The objects snap to the nearest grid marker when you move them around 
on the page.

To display or hide the grids, do the following:

■ Select the Grid option from the Layout menu to view grids.

■ Deselect the Grid option from the Layout menu to hide grids.

Positioning Inserts

You can position the insert or CD label at any location on the physical 

page. For an approximate position, use the box at the intersection 
of the two rulers.

To position the insert or label, follow these steps:

■ Drag the box at the intersection of the ruler to the position on the 
page where you want the upper left corner of the insert or label to be 
located.

For more precise control over the position of the insert or label, use the 
Origin settings in the preferences. See “Setting Insert Layout Options” in 
the Easy CD Creator online Help.
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Adding Text

You can add as much text as you like to the jewel case insert or CD label. 
When you add text, you can define some attributes, such as font style, 
color, and background fill color. 

To add text, follow these steps:

1. Select Insert Text from the Edit menu. 

2. Type the text in the Text box.

3. Select the text attributes you want by clicking the Fill Color, Text Color, 
or Font buttons:

4. Click OK.

The text is added where the cursor is located on the Jewel Case Layout 
window.

Attribute Description

Fill Color Select the color you want surrounding the 
text.
NOTE: When text is marked Transparent—
meaning that you can see the background 
behind the text— you cannot define a fill 
color.

Text Color Select the color of the text.

Font Select the font, style, and size of the text.
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Editing Text Objects

To change the attributes of any text object, follow these steps:

1. Double-click the text object you want to edit.

2. Select the text attributes you want to change. (See “Adding Text” on page 
7-5.)

3. Click OK.

Adding Graphics

The graphics used in Easy CD Creator are called OLE objects. OLE is a 
Windows feature that maintains associations with objects across different 
applications. For example, if you add an OLE object to a jewel case insert 
or CD label, you can double-click the object to open the associated 
application so you can edit the object.

To create and insert an OLE object, follow these steps:

1. Select Insert and New Object from the Edit menu. A list of Object Types 
appears.

2. Select the Create New option to the left of the Object Types list.

Select Create From File instead if you want to import an existing graphics 
file—for example, a piece of computer “clip art.”

3. Select from the Object Type list the application you will use to create the 
graphic. For example, select Bitmap Image if you want to create a 
graphic with Windows Paintbrush.

4. Click OK.

5. Create (or select) the graphic. The way in which you do this depends on 
which application you selected. For example:

If you select Bitmap Image a small window will appear in the middle of 
the Jewel Case Layout window. Create the bitmap image in this window, 
using the Windows Paintbrush tools that appear on the screen. When 
you are finished, click outside the small window to “paste” the image 
into the jewel case insert or CD label.
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If you select Microsoft Clipart Gallery, you will see a window with small 
images of the available graphics. Select the graphic you want and click 
Insert.

6. Move or resize the graphic, as required.

NOTE: See the “Adding Graphics” topic in Easy CD Creator online Help for 
information on editing and moving objects.

Arranging Track Titles

Information about tracks listed in the Audio CD Layout is automatically 
added to the Jewel Case Layout window. If you delete tracks while 
making an audio CD, the associated information is automatically 
updated in the Jewel Case Layout tab.

Deleting tracks while preparing to make an audio CD may cause blank 
rows to appear in the tracks list of the Jewel Case Layout tab. Therefore, if 
you make changes to the track list that affect the position of the tracks 
on the Jewel Case Layout window, Easy CD Creator asks if you want the 
tracks automatically repositioned.

The Jewel Case Layout tab provides some commands that let you create 
columns of track information, display the length and number of each 
track, and automatically position tracks on the layout.

The following sections describe different ways you can arrange the tracks 
in the Jewel Case Layout.

Creating Track Column Lists

You can arrange the track information boxes:

■ Randomly by dragging them to new positions in the Jewel Case 
Layout window, or 

■ In a linear list with one or two columns.

To create a track list:

■ Select One Column or Two Column from the Text menu.
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Displaying Track Numbers and Duration Times

Easy CD Creator includes the track number and duration time for each 
audio track. The track number indicates the order in which the audio 
tracks are recorded. The duration time is shown in minutes and seconds.

To display the track numbers:

■ Select Display Track Number from the Text menu.

To display track duration times:

■ Select Display Track Time from the Text menu.

Fitting Tracks on a Page

Fitting tracks means all the track information is centered on each page 
and aligned along the first character of each track.

You can move track titles from the inside jacket and the back cover to the 
front cover. However, Best Fit will move tracks back to their original 
location.

To fit the tracks on the page as described above:

■ Select Best Fit from the Arrange menu.

Printing Jewel Case Inserts and CD Labels

You can print a jewel case insert or a CD label while the Jewel Case 
Layout tab is open. The commands and options available for printing 
depend on the type of printer connected to your computer. For 
information about these options, see your printer’s guide.

To print a jewel case insert or a disc label, follow these steps:

1. Select Print from the File menu.

2. Click OK.

To preview an insert or label before printing it:

1. Select Print Preview from the File menu.

2. Click OK.
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Getting Help
For setup and connection problems with your CD-Writer Plus, refer to 
the Troubleshooting section of the user’s guide.

For information about Easy CD Creator, refer to the appropriate topics in 
the online Help. To access the Easy CD Creator online Help, select Help 
Topics from the Help menu.

Technical information, including product literature, answers to 
commonly asked questions, information on software upgrades and other 
topics is available electronically through the following:

■ Adaptec World Wide Web (WWW) site at http://www.adaptec.com.

■ The Adaptec Software Products Group can be found on several 
CD-ROM, CD-R, and CD publishing newsgroups and lists on the 
Internet.

For customer support information, refer to Appendix B, “Customer 
Support.”
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Chapter 8:
Copying CDs

CD Copier is a convenient tool for making copies of your CDs. The most 
common reason for making a copy of a CD is to create a working copy of 
a CD and archive the original in a safe place.

NOTE: CD Copier is designed to assist you in reproducing material in which 
you own the copyright or have obtained permission to copy from the copyright 
owner. Unless you own the copyright or have permission to copy from the 
copyright owner, you may be violating copyright law and be subject to payment 
of damages and other remedies. If you are uncertain about your rights, contact 
your legal advisor.

What Types of CDs Can I Copy?
You can use CD Copier to make backup copies of almost any type of CD. 
The following table lists the types of CDs that can be copied and includes 
some notes about making backup copies:

Type of CD Notes

Audio or 
CD Extra

If you are using a drive other than a CD-Writer Plus, 
you need a source CD-ROM drive capable of reading 
audio digitally. Not all drives support digital audio 
extraction. See “Testing Your System Configuration” in 
the CD Copier online help. (CD Copier tests your drive 
to determine its capabilities when the source CD is 
inserted.)

NOTE: CD Copier supports copying CDs in Track-at-Once 
mode. This means that there will be two seconds of silence 
between tracks.
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Starting CD Copier
Follow these steps to start CD Copier:

1. Start up your computer.

2. Insert a blank CD-R or CD-RW disc in the CD-Writer Plus. After a few 
seconds a screen will appear which asks you to “Please select the type of 
CD you wish to create.”

NOTE: If no screen appears after about 15 seconds, you may have inserted a 
disc that is already formatted. Remove the disc and insert a blank disc. Or the 
“Auto insert notification” option may be disabled (this applies to Windows 95 
only). To check this, click Start, move the mouse pointer over Settings, and 
click Control Panel. In Control Panel, double-click System and select the 
Device Manager tab. Double-click the icon for the CD-Writer Plus, then select 
the Settings tab. Click Auto insert notification if it does not have a check 
mark next to it, and click OK. Click OK on the System Properties dialog box. 
Then close the Control Panel.

Data CD Some CD-ROM drives may not be able to read a 
DirectCD data disc. If you have a true MultiRead 
CD-ROM drive, there should be no problems.

Mixed-Mode Mixed results. Some CDs copy perfectly; others do not, 
possibly because the CD is formatted to circumvent 
copying or because some CDs do not follow the 
standard specifications.

Photo CD Requires a source CD-ROM drive that can read 
CD-ROM XA. Most current drives support this.

Video CD Requires a source CD-ROM drive that can read 
CD-ROM XA. Most current drives support this.

Type of CD Notes
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3. Select Click here to create a duplicate of an existing audio CD or data 
CD. The CD Copier Source and Destination tab appears.

NOTE: You can also start CD Copier by clicking the Windows Start button 
(located on the left side of the taskbar), selecting Programs, pointing to HP 
CD-Writer Plus, and selecting Copy CDs.

Making a Copy of a CD
To make a backup copy of a CD, follow these steps:

1. Select the source drive from which you want to copy the CD. This can be 
your CD-R, CD-RW, or CD-ROM drive. See “Source CD-ROM Drives for 
CD-to-CD Copying” in the CD Copier online Help if you are going to 
copy directly from a CD-ROM drive.

2. Select the destination drive that contains the blank CD. This is your 
CD-Writer Plus.

3. Make changes, if any, in the Advanced tab settings. See “CD Copier 
Advanced Tab Settings” on page 8-4.

4. Select one of the following options:

■ Test—Select this option to perform a test in which the files to be 
recorded are passed to the CD recorder. No information is recorded to 
the CD. Use this option if you have made any changes to your CD 
recorder setup.
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■ Test & Copy—Select this option to perform a test in which the files to 
be recorded are passed to the CD recorder. Recording begins after a 
successful test.

■ Copy—Select this option when you do not want to perform the test. 
Use this option if you have successfully recorded a number of similar 
CDs and you have not made any changes to your CD recorder setup.

5. Select the number of copies you want to make.

6. Click Copy to begin recording a copy of your CD.

7. Follow the on-screen instructions and insert a blank CD when prompted 
(if you did not already insert one earlier).

CD Copier begins copying the files and folders from your source to a 
blank CD. A final message box notifies you when the copying is 
complete.

CD Copier Advanced Tab Settings

Setting Description

Current CD 
Recorder Speed

Select the speed at which you want to create the 
backup copy of the CD. For greater certainty, 
record at 1x.

Disc Copy Select this option to copy the source CD to your 
hard drive first to speed up the recording process 
if you are making more than one copy of a CD. 
Once the source has been copied to your hard 
drive, CD Copier records the disc copy to the CD.

Select Location To make a disc copy, type in a different location 
to store the image file if you do not want to use 
the Temp directory.
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Getting Help
For setup and connection problems with your CD-Writer Plus, refer to 
the Troubleshooting section of the user’s guide.

For information about CD Copier, refer to the appropriate topics in the 
online Help. To access the CD Copier online Help, select Help Topics 
from the Help menu.

Technical information, including product literature, answers to 
commonly asked questions, information on software upgrades and other 
topics is available electronically through the following:

■ Adaptec World Wide Web (WWW) site at http://www.adaptec.com.

■ The Adaptec Software Products Group can be found on several 
CD-ROM, CD-R, and CD publishing newsgroups and lists on the 
Internet.

For customer support information, refer to Appendix B, “Customer 
Support.”
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Chapter 9:
HP Simple Trax

Use Simple Trax to index the contents of your CDs. Locate stored files 
without inserting a single CD.

Welcome to HP Simple Trax
HP Simple Trax protects your data by copying files and folders to a CD 
and saving information about them in the Simple Trax information vault 
on your hard drive. This makes it easy for you to find and retrieve any 
protected version of a file you need.

HP Simple Trax is designed to work just the way your Windows Explorer 
works. You can drag and drop items or use the menus. You can also click 
on items with the right mouse button to use the popup menus. Use your 
favorite method or try a new one.

The installation program will place the HP Simple Trax icon on the 
desktop and under My Computer. When you open or explore the Simple 
Trax icon, instead of folders, you see icons representing all the CDs you 
have used to protect your files with HP Simple Trax. You can see which 
files and folders are in each CD without putting a CD in your CD-Writer. 
Retrieving one or more files or folders from a CD is a snap — just treat 
the Simple Trax folder as a regular CD drive and copy the files using HP 
Simple Trax's handy popup menus. HP Simple Trax asks you for the 
correct CD(s) as needed to retrieve the selected files.

You don’t have to log or track what is stored on your CDs, HP Simple 
Trax does it for you automatically. You can create a list of important files 
or folders that you want to protect regularly and even schedule 
protection to take place automatically when you are not using your 
computer. It's that easy to protect all your important information!

With HP Simple Trax, your important files are secure and easy to retrieve. 
You can even retrieve older versions of files, allowing you to undo major 
revisions or changes. HP Simple Trax also helps you find the file(s) you 
want to retrieve, including specific versions of a file, with its search 
option.



9-2 Protecting Files and Folders Immediately

HP Simple Trax is installed along with your other CD-Writer Plus 
software. No special installation or configuration is necessary. All you 
need to do before using HP Simple Trax is to prepare a CD for writing 
with your CD-Writer Plus. The method to prepare a CD can be found in 
“Making Data CDs to Use on Your Own Computer” on page 5-1.

This chapter shows you how to:

■ Protect files and folders on CD

■ Create a Protection List

■ Schedule a protection session to run automatically

■ Retrieve protected files and folders

■ Search the HP Simple Trax information vault

■ Reconstruct the HP Simple Trax information vault

■ Import a CD into HP Simple Trax

■ Use the HP Simple Trax Control Panel

For more complete information on any topic see the on-line help.

Protecting Files and Folders Immediately
To protect files and folders immediately:

1. Place the CD you want to use to protect information into your CD-Writer 
Plus.

2. Run Explorer by clicking the Start button, pointing to Programs, and 
clicking Windows Explorer.

3. Click the file or folder you want to protect with the right mouse button. 
A popup menu appears.

To select multiple files or folders within a single folder, press and hold 
the CTRL key while clicking the desired items with the left mouse button. 
Then release the CTRL key and click with the right mouse button.
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4. Point to HP Simple Trax and click Protect... from the HP Simple Trax 
menu.

The View Versions option only appears if you have selected a single file.

HP Simple Trax copies the selected file(s) and folder(s) to the CD in your 
CD-Writer Plus and places information about the protected files into its 
information vault.

If the CD you placed in your CD-Writer Plus has not been used with HP 
Simple Trax before, the program prompts you to type a name to identify 
the CD. This name is used only in the HP Simple Trax information vault. 
Be sure to write the same name on the CD label.

NOTE: When you use Direct CD to write to your CD-Writer Plus directly, as 
described in chapter 5, HP Simple Trax does not save any information about 
this operation in its information vault. For HP Simple Trax to save information 
about the files you are protecting you must use the HP Simple Trax popup 
menus as described above, drag and drop to the HP Simple Trax icon, or copy 
and paste on the HP Simple Trax icon.

Creating a Protection List
The HP Simple Trax Protection List contains all files and folders you have 
designated for protection. You can then schedule a protection session to 
copy all items in the Protection List to a CD at once. This is a much more 
efficient method of protecting your important information because it 
copies all designated files and folders in one operation, saving you time 
and effort.

To add files and folders to the Protection List:

1. Run Explorer by clicking the Start button, pointing to Programs, and 
clicking Windows Explorer.
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2. Click the file or folder you want to protect with the right mouse button. 
A popup menu appears.

To select multiple files or folders within a single folder, press and hold 
the CTRL key while clicking the desired items with the left mouse button. 
Then release the CTRL key and click with the right mouse button.

3. Point to HP Simple Trax and click Add to Protection List from the HP 
Simple Trax menu.

The View Versions option only appears if you have selected a single file.

HP Simple Trax places the selected file(s) and folder(s) in the Protection 
List.

4. Repeat steps 2 and 3 for any other files or folders that you want to add to 
the Protection List.

To protect the files and folders in the Protection List, use the HP Simple 
Trax Control Panel Schedule Setup tab. See the next section or the HP 
Simple Trax Control Panel section later in this chapter for more 
information.

Scheduling a Protection Session to Run 
Automatically

HP Simple Trax allows you to schedule a protection session to run at a 
specified time on selected days. Scheduled sessions automatically protect 
all files and folders in the Protection List so you don't have to remember 
to do so. You can even schedule a protection session to run in the middle 
of the night or any other time your computer is on but not in use.
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For a scheduled protection session to run unattended you will need to 
have a CD that already has a name for use in HP Simple Trax. If it is the 
first time you use the CD in HP Simple Trax the software will prompt you 
to type a name to identify the CD when the session begins.

To schedule a protection session:

1. Double-click the HP Simple Trax Control Panel shortcut on your 
desktop or click the Start button and point to Programs, then to HP CD-
Writer Plus, then to HP Simple Trax, and select Control Panel from the 
HP Simple Trax menu.

2. Click the Schedule Setup tab. The following screen appears:

3. Use the row of buttons along the top of this tab to select the day(s) to 
perform a scheduled protection session. Click the desired day button(s).

4. Set the time you want the scheduled protection session to start on the 
selected day(s).

5. Select the desired protection option:
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■ All files in the list: Protects every item in your Protection List, 
whether changed or not.

■ Only changed files: Protects only those items in your Protection List 
that have changed since the last protection session.

6. Click OK to schedule the protection session.

Be sure to place the desired CD in your CD-Writer Plus before the 
scheduled protection session is set to begin. Since the first time you use a 
CD in HP Simple Trax the program prompts you to type a name to 
identify the CD, make sure you have already used the CD in HP Simple 
Trax for the scheduled protection session to run unattended.

Leave your computer on so the scheduled protection session can run.

Click Run Now if you want to protect the items on your Protection List 
immediately. The protection session will still run as scheduled.

Retrieving Protected Files and Folders
Retrieving protected files and folders using HP Simple Trax is very quick 
and easy. You don’t need to insert a CD into your CD-Writer Plus before 
the retrieval actually begins. HP Simple Trax shows you all the files and 
folders you have protected on all CDs and prompts you for the correct 
CD(s) during the retrieval process. Since HP Simple Trax automatically 
gives you the most recent version available of a file you may have to 
insert a CD you didn’t expect to.

To retrieve protected files and folders:

1. Run Explorer by clicking the Start button, pointing to Programs, and 
clicking Windows Explorer.

2. Double-click the Simple Trax icon.
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3. Double-click the CD label for the CD from which you want to retrieve 
files or folders. Open the folder containing the file(s) and folder(s) you 
want to retrieve.

If you do not know which CD contains the files or folders you want to 
retrieve, click the Tools menu, point to Find, and click In Simple Trax... 
to use HP Simple Trax Find feature.

4. Click the file or folder you want to retrieve with the right mouse button. 
A popup menu appears.

The View Versions option only appears when you right-click on a file. 

To select multiple files or folders within a single folder, press and hold 
the CTRL key while clicking the desired items with the left mouse button. 
Then release the CTRL key and click with the right mouse button.

5. Click Retrieve from the popup menu.

6. Set the retrieve options:

■ Make sure Ask before overwriting files is checked to prevent 
retrieved files from overwriting existing files of the same names 
without HP Simple Trax prompting you to do so first.
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■ Make sure Include subdirectories is checked to retrieve all 
subdirectories in the selected folder. (This option is useful only if you 
have selected one or more folders.)

■ Click Copy files to an alternate location and type the desired drive 
and path or click Browse and select the new location from the list of 
folders on your hard disk(s).

NOTE: If you choose to retrieve the selected files or folders to an alternate 
location, all of the retrieved files are removed from the original folders and 
subfolders and are placed in the alternate location. If you want to keep the 
directory information either drag and drop the items or use copy and paste.

7. Click OK to continue.

8. Insert the correct CD if it is not already in your CD-Writer Plus. HP 
Simple Trax prompts you for the required CD.

9. Confirm that you want to replace existing files, if prompted to do so. 

HP Simple Trax retrieves the most recent versions of files that you 
selected. In order to do this HP Simple Trax may prompt you for different 
CDs depending where the most recent version was copied.

TIP: If you are using multiple CDs disable the DirectCD banner.

You can also retrieve earlier versions of a file using the View Versions 
option. This option will bring up the File Protection History dialog box, 
which lists all the protected versions of the file. The most common 
reason for retrieving an older version of a file is to undo major revisions 
or changes.

To display the File Protection History dialog box run Explorer, click the 
file on your hard disk that you want to examine with the right mouse 
button, point to HP Simple Trax on the popup menu, and select View 
Versions. You can also double-click the HP Simple Trax icon, click the file 
you want to examine with the right mouse button, and select View 
Versions.
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The File Protection History dialog box appears:

To retrieve an older version of a file, click the desired file version in the 
File Protection History dialog box and click the Retrieve button. Older 
versions of a file can only be retrieved one at a time.

Searching the HP Simple Trax Information 
Vault

HP Simple Trax helps you find protected files in the HP Simple Trax 
information vault so that you can see if a file has been protected, see 
when it was last protected, and retrieve it if desired.
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To find protected files in the HP Simple Trax information 
vault:

1. Run Explorer by clicking the Start button, pointing to Programs, and 
clicking Windows Explorer.

2. Double-click the HP Simple Trax icon.

3. Click the Tools menu, point to Find, and click HP Simple Trax... to 
display the Find dialog box.

4. In the Named box, type all or part of the filename you want to find.

You can use a file filter to search for files or folders based on name 
patterns.

A file filter is a generalized description of a filename composed of a 
partial filename and one or more of the wildcard characters. The wildcard 
characters take the place of one or more letters or numbers to help you 
find a file whose name you do not know or specify a group of files with 
similar names. The wildcard characters are:

* = any number of characters

? = a single character

Examples:

■ To find all files that end in .txt, type *.txt

■ To find all files that end in .wp and one additional character, type 
*.wp?

■ To find all files that begin with report and have any extension, type 
report.*

5. To limit the search to a specific CD, drive, or folder, click the desired CD, 
drive, or folder in the Look in: box.

6. Click Find Now to begin searching.

If you want to stop the search click Stop.
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If you do not know the name of the file(s) or folder(s) you want to find, 
click the Date tab to search the information vault for items created, 
modified, or protected during a specified period of time.

Click a file with the right mouse button to retrieve it or view protected 
versions.

The HP Simple Trax Find menu provides additional options. Refer to the 
on-line Help for complete information.

Reconstructing the HP Simple Trax 
Information Vault

If for any reason the information that HP Simple Trax stores about files 
and folders you have protected is lost or damaged it can be reconstructed. 
To fully reconstruct the information you must import all of the CDs that 
you have used to protect files in HP Simple Trax.

Importing CDs into HP Simple Trax
When you import a CD, HP Simple Trax gathers information about the 
files on the CD and stores that information on your hard drive. This 
information makes it possible for you to easily find and retrieve files and 
to browse the contents of the CD without putting the CD in your CD-
Writer Plus.

There are several cases in which you may want to import a CD:

■ If for any reason the information HP Simple Trax stores on your hard 
drive is lost or damaged you can reconstruct that information by 
importing all Simple Trax CDs.

■ If you want to start tracking files that you have previously copied to 
CDs without using HP Simple Trax.

■ If you took a CD with files you are working on to another computer, 
modified them, and now want to update the information that Simple 
Trax stores about those files.
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■ If you want to start tracking files on a CD created by someone else.

To import a CD into HP Simple Trax:

1. Place the CD whose contents you want to import into your CD-Writer 
Plus.

2. Run Explorer by clicking the Start button, pointing to Programs, and 
clicking Windows Explorer.

3. Right-click the drive icon for your CD-Writer. A popup menu appears.

4. Point to HP Simple Trax and click Import from the HP Simple Trax menu.

The import process can take anywhere from a couple of minutes to over 
an hour. The duration of the operation depends mainly on the type of 
computer you have and the number of files on the CD.

If the CD you placed in your CD-Writer has not been used with HP 
Simple Trax before, the program prompts you to type a name to identify 
the CD. This name is used only in HP Simple Trax. Be sure to write the 
same name on the CD label.

HP Simple Trax Control Panel Overview
The HP Simple Trax Control Panel provides access to many HP Simple 
Trax options. The HP Simple Trax Control Panel has three notebook tabs 
that organize the available functions:

■ Selection: The Selection tab gives you full control over the HP Simple 
Trax Protection List, allowing you to add and remove files and folders 
as needed to protect your valuable information.

■ Schedule Setup: The Schedule Setup tab allows you to schedule 
automatic protection of all items in the Protection List.

■ Error Logs: An error log is automatically created during every 
protection or retrieval session whether or not an error occurs. You 
may wish to consult the error log for additional information in the 
event that an error message appears during an operation.
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To run the HP Simple Trax Control Panel, double-click the HP Simple 
Trax Control Panel shortcut on your desktop or click the Start button, 
point to Programs, then to HP CD-Writer Plus, then to HP Simple Trax, 
and click Control Panel.

Selection Tab

The Selection tab gives you full control over the HP Simple Trax 
Protection List, allowing you to add and remove files and folders as 
needed to protect your valuable information.

The HP Simple Trax Control Panel Selection tab is divided into two 
sections:

Available Files

■ Drive List: Choose the drive you want to work with from this drop-
down list.
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■ Folder List: Click the folder you want to open.

■ File List: Displays the files in the selected folder that meet the criteria 
specified by the File Selection radio buttons.

■ File Selection Radio Buttons: Control how files are displayed and 
selected for protection. There are three options:

1. All Files & Folders: Selects all files and any subfolders in the current 
folder for protection. The contents of the current folder appear in the 
File List.

2. File Type: Specifies the type of files that are selected for protection 
and displayed in the File List. Type the desired file filter in the 
accompanying combo box or select a file filter you have used before 
from the drop-down list. Only filters of the form *.??? are allowed. 
Some examples of these filters are *.bmp, *.doc, and *.txt. The 
advantage of using a file type when creating a Protection List is that 
future files of that type are automatically included.

3. Individual Files: Allows you to choose the specific files to be 
protected from the File List. Click the desired file(s).

■ Add to List Button: Adds the selected files to the Protection List.

Protection List

■ Protection List: Contains all files and folders you have designated for 
protection. You can then schedule a protection session to copy all 
items in the Protection List to a CD at once.

■ Remove from List Button: Click the items you want to remove from 
the Protection List and click this button.

Schedule Setup Tab

The Schedule Setup tab allows you to schedule automatic protection of 
all items in the Protection List.

The controls on this tab are contained in a single group:

■ Day of the Week Buttons: Use this row of buttons to select the day(s) 
on which to perform a scheduled protection session. You can click as 
many days as desired. The selected day buttons remain pressed. To 
remove a day from the schedule, click the desired button.

■ Options: These radio buttons set the protection options.
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All files in the list: Protects every item in your Protection List, 
whether changed or not.

Only Changed files: Protects only those items in your Protection List 
that have changed since the last protection session.

■ Start Time: Type the time at which the scheduled protection session 
is to begin. The Start Time is the same for all selected days.

■ Run Now... Button: Click this button to protect all items in your 
Protection List immediately.

Error Logs Tab

An error log is automatically created during every protection or retrieval 
session whether or not an error occurs. You may wish to consult the error 
log for additional information in the event that an error message appears 
during an operation.

The controls on this tab are contained in a single group:

■ Error Log List: This portion of the tab displays information about the 
error logs and allows you to select a specific error log so that you can 
get more information on any errors that occurred. 

■ View Button: Click the error log you want to open and click this 
button. Use this option to see the details of any errors that occurred. 
The information contained in the error log can help you solve the 
problem.

■ Delete Button: Click the error log you want to delete and click 
Delete.

CAUTION: When you delete an error log, it cannot be restored.

■ Keep last x error log entries: Click this radio button to set the 
number of error log entries HP Simple Trax is to keep. Type the 
number of error logs to keep or use the spin buttons to set the desired 
number. When this number is exceeded, the oldest error log is 
automatically deleted.

■ Keep all error log entries: Click this radio button to keep all error log 
entries. You can then delete unwanted entries manually using the 
Delete button.
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HP Simple Trax’s seamless integration to Explorer makes protecting and 
retrieving your valuable information easy. Schedule protection sessions 
of your important documents so that they will always be available. Keep 
your hard drive from getting cluttered by versions of files you think you 
might want in the future by protecting them with HP Simple Trax.
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Chapter 10:
HP Disaster Recovery

HP Disaster Recovery is an application that will help you to recover your 
data and operating system after a hard drive failure. It is important that 
you create a Disaster Recovery Set as soon as possible. Should a disaster 
occur, the information in the Disaster Recovery Set will enable you to 
return your system to the state it was in before the hard drive failure.

Before recovering with HP Disaster Recovery, you should first decide if 
another recovery method is possible. For example, if the problem appears 
to be associated with the Windows operating system, such as a corrupt 
registry, try to recover by following the steps outlined in your Microsoft 
Windows User’s Manual before attempting the following procedures.

Getting Started
The first step in securing the data on your system is creating the Disaster 
Recovery (DR) Set. The DR Set will contain the information necessary to 
recover your system. Throughout this chapter, we will refer to the disks, 
diskettes and discs that make up the Disaster Recovery Set. For more 
information on these terms, please see the “HP Disaster Recovery 
Glossary” on page 10-8. 

The Disaster Recovery Wizard will guide you through the steps required 
to create the DR Set with easy-to-follow instructions for protecting your  
valuable data. Once the DR Set has been created, it will allow you to 
recover your system should your hard drive fail, even if  your Windows 
operating system will not start.

When you install HP Disaster Recovery, the program and its folder are 
added to the Windows Start Menu. 
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What you will need

To create the Disaster Recovery Set, you will need the following items:

For Windows 95 and Windows 98

■ One or more blank, formatted 1.44MB diskettes*

■ Windows 95/98 installation CD

■ One or more blank HP CD-R/CD-RW discs*

For Windows NT

■ Four (4) blank, formatted 1.44MB diskettes

■ Windows NT installation CD

■ One or more blank HP CD-R/CD-RW discs*

*The number of diskettes and CD-R/CD-RW discs required will depend on the 
amount of data on your system. For more information on these requirements, 
see “HP Disaster Recovery Glossary” on page 10-8.

Creating the Disaster Recovery Set

To create your Disaster Recovery Set:

1. Click Start, Programs, HP CD-Writer Plus, HP Disaster Recovery, 
Disaster Recovery.

HP Disaster Recovery Wizard appears. 

2. Follow the instructions on the Wizard screens to create your Disaster 
Recovery Set.

It is recommended that you label your diskettes and discs when 
prompted in the Wizards, and store them in a safe place. A new Disaster 
Recovery Set should be created when new hardware or software has been 
added to your system, or if many changes have been made to your files 
since the last DR Set was created.



Testing your Disaster Recovery Set 10-3
C

h
ap

ter 10:  H
P D

isaster 
R

eco
very

Testing your Disaster Recovery Set
NOTE: This section applies to Windows 95 and Windows 98 only.

After you have created the Disaster Recovery Set, you will be asked if you 
would like to test the DR Set. Testing the DR Set is very similar to 
performing an actual recovery; however, be sure to stop before recovering 
your data. This test is to verify that your drive is responding properly.  

To test your Disaster Recovery Set:

1. Follow steps 1 through 7 for recovering your data in the Data Recovery 
section. See “Recovering Your Data” on page 10-4.

WARNING: Do not continue to step 8 when testing the DR Set. By pressing 
Enter, as directed in step 8, you would be recovering the data from the diskette 
which would overwrite the data on that drive. Press Esc to cancel, or remove the  
diskette and restart your computer.

2. If you do not receive the messages listed in the steps for data recovery, 
follow the directions for creating another Disaster Recovery Set. See  
“Creating the Disaster Recovery Set” on page 10-2.
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Recovering Your Data
If you are certain that you have lost your data due to a major system 
problem, such as a hard drive failure, it will be necessary to recover your 
data by using the most recent Disaster Recovery Set. Please note that the 
process for recovering data in Windows NT differs from that for Windows 
95 and Windows 98. 

What you will need

To recover the data on your system, you will need the following items:

For Windows 95/98 and Windows NT

■ HP Disaster Recovery Set

■ HP CD-Writer Plus drive

Data Recovery

For Windows 95 and Windows 98

If necessary, you can prepare your hard disk using the following tools 
which are located on the Disaster Recovery Diskette:

■ FDISK—Re-partitions your hard disk

■ FORMAT—Formats one or more partitioned drives

■ SYS—Installs the system boot files onto the hard disk

NOTE: For instructions on the use of these utilities, please refer to your 
operating system user manual or contact your operating system’s manufacturer.

To recover your data:

1. Replace any lost hard drives with comparable drives. 

NOTE: In order to recover all of your information, HP Disaster Recovery must 
have at least as much hard disk space as existed before the drive failure.

2. Insert the Windows Startup Disk (diskette #1 of the DR Set) into your 
machine’s 3.5” boot floppy drive and restart your computer. 
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A DOS screen appears.

3. At the prompt, type A:\README then press Enter. 

The README.TXT appears. 

4. After reading the text, press Alt+F, then press X to exit the editor.

5. If a Windows Startup Diskette #2 was created (not all systems require the 
creation of a second diskette), insert that diskette into your machine’s 
3.5” boot floppy drive.

6. At the prompt, type A:\RECOVER and press Enter. Your system files will 
be copied from the diskette to your hard drive.

The following message should appear:

Please insert Disaster Recovery Disc #1 into your 
HP CD-Writer Plus.

7. Insert DR Disc #1 into your HP CD-Writer Plus, then press Enter.

NOTE: If your Disaster Recovery Set consists of more than one disc, you will be 
prompted to insert each of the discs in the order they were created.

The following message should appear:

Select the volume that you wish to recover.                                                   

Drive C: [Volume C Name]                                                                              
Drive D: [Volume D Name]

NOTE: If you have only one drive, it will be automatically selected for recovery 
and this screen will not be displayed.

WARNING: For Windows 95 or Windows 98—If you are testing the Disaster 
Recovery Set, the test is complete. Do not continue past this step. Please remove 
the Windows Startup Disk from your floppy drive and restart your computer. If 
you are recovering your data, continue to step 8.

8. Select the volume that you wish to recover by highlighting the volume 
using the Up and Down arrow keys, then pressing Enter.

You will then be asked to confirm your selections before recovering your 
information. 

9. Press Enter to confirm your selections. 
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NOTE: If Disaster Recovery Disc #1 is not in your HP CD-Writer Plus, you will 
be prompted to insert it at this time.

Disaster Recovery will begin recovering the Windows File System.

10. Once the volume has been recovered, a summary of the process will be 
displayed. To exit this screen, press Enter. If there is more than one 
volume to be recovered, you may select it at this time.

After recovering the volume(s), you may wish to view the REPORT.TXT 
file which contains a text summary of the files that could not be 
recovered. If you wish to view this file, you must first exit the program by 
pressing the Esc key twice, then typing EDIT REPORT.TXT. After 
reading the text, press Alt+F, then press X to exit the editor. 

Your recovery is complete. Remove any diskettes and discs from your 
machine and restart your computer. 

NOTE: It may be necessary to restart your computer more than once if any 
hardware in your system has changed since your DR Set was created.

For Windows NT

A minimal install of the Windows NT Workstation will be performed 
from the Disaster Recovery Set.

HP Disaster Recovery screens will display messages instructing you when 
to insert each of the four diskettes from your Disaster Recovery Set.

To recover your data:

1. Insert the Windows NT Workstation Setup Boot Disk (diskette #1 of the 
DR Set) and restart your computer. You will be guided through a partial 
NT installation.

Only the boot drive and the NT installation drive need to be partitioned 
at this time. You will be able to partition and format other drives at a 
later time through the Disk Administrator in the HP Disaster Recovery 
process.

2. Restart your computer when prompted.

The DR Wizard should appear now and guide you through the steps 
necessary to recover your system.
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NOTE: If setup determines that your primary partition is not set up (i.e. if your 
C drive is not partitioned or formatted), then you will be prompted to do so.  
You should attempt to partition any new drive(s) to the same settings as were 
set before the drive failure.
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HP Disaster Recovery Glossary
This glossary contains common computer terms used in this chapter, and 
terms that relate specifically to HP Disaster Recovery.

BIOS                           An acronym for Basic Input Output System, a low-level operating system 
that runs below Windows and DOS.

blank HP CD-R         HP manufactured CD-R (compact disc recordable) that has no data         
written to it.

blank HP CD-RW     HP manufactured CD-RW (compact disc re-writable) that contains no 
data, or contains data which can be overwritten.

disc                            HP manufactured CD-R (compact disc recordable) or CD-RW (compact 
disc re-writable).

diskettes/disk           The floppy disks required to create the Disaster Recovery Set. Must have 
the following attributes:

■ 3.5”

■ 1.44MB

■ blank/formatted (no data)

DR set                        Disaster Recovery Set consisting of the diskettes and discs which contain 
the information necessary to recover your data in the event of a hard 
drive failure. 

Windows 95/98 users will require:

■ Up to two (2) blank, formatted 1.44MB diskettes

■ Windows 95/98 installation CD

■ One or more blank HP CD-R/CD-RW discs

Windows NT users will require:

■ Four (4) blank, formatted 1.44MB diskettes

■ Windows NT installation CD

■ One or more blank HP CD-R/CD-RW discs

DOS                           An acronym for Disk Operating System, a simple operating system that 
resides on your Windows 95/98 Startup Disk.  
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dual boot system       A system that has two OS (operating systems). For example, Windows 95   
and Windows NT.

hard disk                   A storage-media disk fixed permanently within a drive unit and used for 
storing computer data.

partition                   A logical section of your hard disk. One physical hard disk may be 
partitioned into two or more logical hard drives.
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Appendix A:
Technical Information

Minimum System Requirements
Your computer should meet or exceed these requirements:

■ IBM or compatible computer with Pentium/100 Mhz processor or 
above

■ Microsoft® Windows 95®, Windows 98®, or Windows NT® 4.0

NOTE: For Windows NT, Service Pack 3 is required.

■ 16 MB RAM 

■ Hard drive with at least 528 MB storage capacity (with a transfer rate 
of at least 800 kB/sec and disk access time of less than 20 msec)

■ 35 MB free hard drive space for installing the software described in 
this User’s Guide.110 MB free hard drive space if your package 
included other software
10 MB free hard drive space for each minute of music to be recorded

■ An available space on an IDE controller (ATA-2 or EIDE)

■ One available half-height drive bay (approximately 6” wide, 1.75” 
high, 8.5” deep /15 cm x 4.5 cm, 21.6 cm deep)

■ A CD-ROM drive to install the application software. 

If your computer does not have a CD-ROM drive:

You can create an Install Assistant diskette on another computer with 
a CD-ROM. The Install Assistant program will provide you with an 
Install Recommendation for your system.

To copy the Install Assistant program to a diskette, insert “Software 
Disc 1” into the CD-ROM drive. From the main menu, click Before 
You Install, then click Make Diskette. 
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Insert the diskette you just made, into your computer’s floppy drive 
and run A:\ASSIST.

You can also order the Install Assistant diskette kit (part number 
C4392-60020) by calling:
(U.S.) 970-635-1500.
(Europe) Your country’s support number is listed under “Telephone” 
on page B-6.

If you know the configuration of devices attached to your IDE 
controllers and understand how to connect your drive you do not 
require an Install Assistant diskette in order to install the software.

What Affects System Performance
How well your computer functions with the CD-Writer Plus drive, 
particularly how fast it writes data to a CD, depends on a number of 
factors. Some of these factors are listed below.

Processor (CPU). The type and speed of your processor greatly affects the 
speed at which your computer transfers data to and from the CD-Writer 
Plus drive. If the processor speed is too slow, you may have to write at 1x 
speed.

RAM. Your computer must have enough memory available to handle its 
operating system, the CD-Writer Plus applications, and the data you are 
transferring to and from CDs. The system should not have to swap data 
to and from the hard drive.

Your Hard Drive. The speed at which your hard drive accesses and 
transfers data (its access time and transfer rate) affects performance. 
Newer hard drives, those with a storage capacity greater than 528 MB, are 
fast enough to handle the CD-Writer Plus drive’s 2x write speed.

IDE Interface Type: CD-Writer Plus should be connected to the primary 
or secondary IDE controller. 

For optimal performance, run SCANDISK.EXE and DEFRAG.EXE on 
your hard drive before using your CD-Writer Plus drive for the first time 
(see your Windows manual for more information). Then run them 
periodically after that. These programs improve access times to the hard 
drive, which will help improve system performance while writing to and 
reading from the CD-Writer Plus drive.
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NOTE: Refer to your computer and mother board manuals or contact your 
computer vendor if you have any questions about your computer’s configuration 
or capabilities.

Drive Specifications
ISO 9660 Disc Data Capacity (74 Minute CD)

*1 MB is defined as 106 bytes

UDF 1.5 Disc Data Capacity (74 Minute CD)
530 MB for CD-RW

618 MB for CD-R

Performance
Buffer size: 991 KB to 975 KB (depending on writing mode)

Average access time (1/3 stroke): < 150 ms

Data transfer rate (recording):
150 KB/s sustained (1x speed)
300 KB/s sustained (2x speed)
600 KB/s sustained (4x speed on CD-R media)

Data transfer rate (reading):
150 KB/s (1x speed, CLV mode)
300 KB/s (2x speed, CLV mode)

Number 
of 
sessions

Size required for header 
information

Size available for data/
per session

1 approximately 23 MB* 627 MB one session

5 approximately 79 MB
(approx. 23 for the first, 
14 MB each of the rest)

114 MB each session

10 approximately 149 MB
(approx. 23 for the first, 
14 MB each of the rest)

50 MB each session

30 approximately 430 MB
(approx. 23 for the first, 
14 MB each of the rest)

7.4 MB each session
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600 KB/s (6x speed, CLV mode)
1200 KB/s (8x speed, CLV mode)
1500 KB/s to 3600 KB/s (10x to 24 x speed, CAV mode)

Error rate: < 1 frame/1012 bits

Audio distortion: < 0.1%

Discs supported
120 mm and 80 mm CD-R (write-once) media 

120 mm CD-RW (ReWritable) media 
For a description of which CD drives can read discs created with 
certain application/media combinations see the interchange 
summary on page 4-4.

Interface
Electrical interface: 

IDE / ATA-2  MMC compliant

Loading mechanism: tray

Logical recording format (depending on application used): 
ISO 9660
UDF 1.5
CD-DA

Dimensions
(5 1/4-inch form factor)

Height: 41.4 mm (1.63 in.)
Width: 146 mm (5.75 in.)
Depth: 203 mm (7.99 in.) Recommended drive bay depth: 8.5 in.
Weight (net): 1 kg (2.2 lbs.)

Environmental
Temperature

operating: 5° to 35° C
nonoperating: -25° to 55° C

Humidity (no condensation allowed)
operating: 10% to 80% RH
nonoperating: 5% to 95% RH

Shock and vibration
HP Corporate Environmental Test Class B1

Power requirements
Typical usage: 10.7 W
Maximum usage: 12.4 W
Sleep mode < 1 W
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Appendix B:
Customer Support

Before You Call HP
If your own troubleshooting efforts fail, contact Customer Support. Make 
sure you are at your system and have your drive installed when you call. 
Phone numbers begin on page B-5. Before you contact them, have the 
information below ready. For help finding this information, see page B-2. 
If you receive an error message, write it down before you call.

Information For your computer

CD-Writer Plus drive model

Drive firmware version

Drive serial number

Computer brand and model

Operating system and version? Windows 95, Windows 98, or 
Windows NT 4.0
Version Number:
(for NT) Service Pack Number:

Amount of RAM installed

Other CD-ROM drives? yes/no
(If yes, list them)

Sound card? yes/no Type:
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Where to Find This Information

CD-Writer Plus drive model

The CD-Writer Plus drive model number appears on a small sticker on 
the underneath side of the tray of the CD-Writer Plus drive, as well as 
on the box. Example: 8100i (internal)

Drive firmware version

In Windows 95, the drive firmware version and model number (above) 
appear in the CD-ROM settings. Right-click on the My Computer icon, 
select Properties, select the Device Manager tab, double-click on 
CDROM. Double-click on the CD-Writer Plus drive, and then click on the 
Settings tab. Example: Firmware revision 1.00

In Windows NT, the drive firmware version and model number (above) 
appears in the CD-ROM settings. Open the Control Panel. Click on SCSI. 
Scroll down the list, double-click on ATAPI. Double-click on the CD-
Writer Plus drive, and then click on the Settings tab. Example: Firmware 
revision 1.00

Drive serial number

The CD-Writer Plus drive serial number appears on the main label on the 
top of the drive. See page 1-7 or page 1-24. It also appears on the 
underside of the CD tray.

IDE controller settings Primary / Secondary / Other
IRQ _______
I/O base address _______
Master in use?_______
Slave in use?_______

Other IDE devices in your 
computer system?
yes/no (If yes, list them)

IDE adapter board brand/model, if 
any

Information For your computer
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Computer brand and model

The computer brand appears on the front of your computer and in the 
documentation that came with your computer. Example: Dell Dimension 
XP-90.

Operating system and amount of RAM installed

In Windows 95, from the Start menu on the task bar, select Settings/
Control Panel. Double-click on System. Select the General tab. Write 
down the version number and the amount of memory installed; for 
example: 4.00.950 and 16 MB RAM.

In Windows NT (while signed on as Administrator), from the Start menu 
on the task bar, select Programs/Administrative Tools (Common)/
Windows NT Diagnostics. Select the Version tab and write down the 
version number and service pack number; for example: 4.00.1381 and 
Service Pack 2. Then select the Memory tab and write down the amount 
of memory listed under Physical Memory - Total; for example: 16 MB 
RAM.

Other CD-ROM drives

Your computer may have come with an internal CD-ROM or you may 
have purchased a CD-ROM drive. Check the documentation that came 
with your computer or CD-ROM drive. Example: Mitsumi 4x CD-ROM

Sound board

Your computer may have come with a sound board and speakers or you 
may have purchased them separately. Check the documentation that 
came with your computer or sound board. Example: Sound Blaster

IDE controller settings

1. Insert the CD labeled “Software Disc 1” into your CD-ROM drive.
2. Click the Start button on the task bar, select Run, 

type D:\ASSIST /S (where D: is your CD-ROM’s drive letter)
and click on OK.

3. Print the results. You will have a list of technical information about 
each IDE controller in your system and each device attached. 

Other IDE devices

Any devices attached to IDE controllers in your computer system, such as 
a CD-ROM drive, hard drive, tape drive, and so on. Example: HP Colorado 
5GB
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IDE adapter board brand/model

If you are using a paddle board to add another IDE controller to your 
computer system, check the manual that came with your IDE board. 
Example: GSI 2C
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HP Customer Support
If you need help with your CD-Writer Plus drive, your local reseller has the latest 
information regarding HP products and services and can provide support under HP's 
comprehensive menu of reseller services. If your reseller is not able to help, you can 
obtain support from HP directly either through free 24-hours/day interactive electronic 
services or by telephone (free during warranty). To get help with the software that came 
with CD-Writer Plus, call the appropriate number listed below (free during warranty).

America Online . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Keyword: hpstor

CompuServe  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Go HPSYS

World Wide Web  . . . . . . . . . . . . . . . . . www.hp.com/isgsupport/cdplus

Bulletin board site (8,N,1,F, 1200-28.8K baud) 
Europe  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . +31 (0)495 546909
Asia/Pacific

Australia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (03) 9890 0276
Korea. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . Hitel: (02) 762-0228 

Access: Go HPK 
Chollian: (02) 220-2001

New Zealand. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (09) 356 6642
Taiwan  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (02)9233233

First Name: HP
Last Name: BBS

HPFirst Faxback Service 
Simply dial the fax number from a touch-tone phone or Group 3 fax machine and 
follow the voice prompts to select the index of available support and product 
information documents.

USA and Canada  . . . . . . . . . . . . . . . . . . . 800-368-9673 or 970-635-1510
Europe

Austria (free line) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 0660 8128
Belgium (free line)
- Dutch . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 0800 11906
- French  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 0800 17043
Denmark (free line)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 800 10453
Finland (free line). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9800 13134
France (free line)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 05 905900
Germany (free line)  . . . . . . . . . . . . . . . . . . . . . . . . . . . 0130 810 061
Italy (free line)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1678 59020
Netherlands (free line) . . . . . . . . . . . . . . . . . . . . . . . . . . 06 022 2420
Norway (free line)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 800 11319
Spain (free line)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 900 993123
Sweden (free line). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 020 795743
Switzerland (free line)
- French  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155 1526
- German  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 155 1527
United Kingdom (free line)  . . . . . . . . . . . . . . . . . . . . . . 0800 960271
Other locations in Europe (toll line) . . . . . . . . . .+31 (0)20 681 5792
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Asia/Pacific
Australia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (03) 9272 2627
China . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (8610) -65055280
Japan. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (3) 3335-8622
Korea. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (02) 769-0543
New Zealand. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (09) 356 6642
Singapore . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (65) 291-7251
Taiwan  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (02)7195589

E-mail  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . SureStore_Support@hp.com

FTP Site . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ftp.hp.com
Login:  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .anonymous
Password:  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (Your email address)
Directory:  . . . . /pub/information_storage/surestore/cd-writer_plus

Telephone 
USA and Canada (6am-10pm weekdays, 8am-5pm weekends, Mountain time;
Starting in November 1998 support available 24 hours a day, 7 days a week)

Literature and dealer referral . . . . . . . . . . . . . . . . . . . . 970-635-1500
Canada (for French-speaking customers)
pour assistance en français. . . . . . . . . . . . . . . . . . . . . . 800-387-3867

During warranty period
- Technical support  . . . . . . . . . . . . . . . . . . . . . . . . . . . 970-635-1500

After warranty period (charges begin only when you connect to a Support Technician, 
prices are subject to change without notice)

Technical Support  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 800-810-0130
(Per incident fee of $25 US dollars charged to 
Visa, MasterCard or American Express)
U.S. only Technical Support. . . . . . . . . . . . . . . . . . . . . 900-555-1800
($2.50 per minute/maximum of $25. You must be 18 years
of age or have parental permission to call 900 numbers.)

Europe (M-F, 8:30-18:00 Central European Time)
Use these Technical Support numbers during and after your warranty period. No charge 
for Technical Support during warranty period. Per incident charge after warranty period.

Austria  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 06 60 63 86
Belgium
- Dutch . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 02 626 88 06
- French  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 02 626 88 07
Czech Republic. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42 2 471 7321
Denmark. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39 29 40 99
Finland . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 02 03 47 288
France . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 01 43 62 3434
Germany. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 0180 52 58 143
Hungary . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 36 1 252 4505
Ireland  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 01 662 55 25
Italy  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 02 2 641 0350
Netherlands  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 020 606 87 51
Norway . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22 11 62 99
Portugal  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 01 44 17 199
Russia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7095 923 5001
Spain. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90 23 21 123
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Sweden . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 08 61 92 170
Switzerland (French, Italian, and German) . . . . . . . . 08 48 80 11 11
Turkey. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90 1 224 5925
United Kingdom. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 0171 512 52 02
English language support from other countries  . +44 171 512 52 02

Latin America
Argentina (M-F, 8:30-19:30) . . . . . . . . . . . . . . . . . . (54) (1) 787 8080
Brazil (M-F, 8:00-19:00)  . . . . . . . . . . . . . . . . . . . . (55) (11) 829 6612
Chile (M-F, 8:30-18:30)  . . . . . . . . . . . . . . . . . . . (56) (2) 800 360999
Mexico (M-F, 8:30-18:30) . . . . . . . . . . . . . . . . . (52) (5) 800 22 14700

(52) (5) 800 90 52900
Venezuela (M-F, 9:00-18:00). . . . . . . . . . . . . . . . . . (58) (2) 207 8488

Asia/Pacific
Australia (M-F 7am-7pm, Eastern Standard Time). . . (03) 8877 8000
China (M-F 8:30-17:30) . . . . . . . . . . . . . . . . . . . . . (8610)-62625666

extensions 5602 through 5609, 5611 and 5612
(8610)-62614174
(8610)-62624175
(8610)-62614176

Korea (M-F, 8:30-19:00)  . . (02) 3270-0700 / 080-999-0700 (toll free)
New Zealand (M-F, 9am to 9pm Auckland Time)  . . . . (09) 356 6640
Singapore (M-F, 9:00-17:00) . . . . . . . . . . . . . . . . . . . . . (65) 272-5300
Taiwan (M-F, 8:30-17:30) . . . . . . . . . . . . . . . . . . . . . . . (02) 717-9609

FAX 
USA. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 970-667-0997
Asia/Pacific

Australia . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (03) 9272 4099
Korea. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (02) 3270-0707
New Zealand. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .(+61 3) 9272 4099
Singapore . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (65) 274-2033
Taiwan  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . (02)5140276
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Returning a Drive
If your Hewlett-Packard product requires repair or replacement, call the 
appropriate number for your country from the list beginning on page B-6 in 
Appendix B: Customer Support, to receive instructions.
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A

access time 3-7, A-2, A-3
adding graphics to inserts 7-6
application software

installing A-1
uninstalling 1-34

arranging track titles 7-7
assigning drive letter 3-4–3-5
audio cable 1-15, 1-29, 3-3

purchasing 1-17, 1-31
Audio CD Layout window 6-4
audio CDs

CD-RW in car CD player 4-2
track-at-once mode 8-1

audio distortion 3-3–3-4, A-3
audio tracks 6-2

combined with wave files 6-7
pre-recording to wave files 6-6
recording 6-3

automatic protection of files 9-4

B

boot order settings 3-3
booting from CD-Writer drive 3-3
buffer size A-3
buffer underrun 3-6–3-7

C

cable select 1-8, 1-25, 1-35, 1-36, 1-37
cables

audio 1-15, 1-17, 1-29, 1-31, 3-3
data 1-11, 1-13, 1-15, 1-29, 1-35, 1-36, 1-

37
power 1-14, 1-19, 1-33, 1-35, 1-36

capacity, CD A-3
CD Copier

changing temp directory location 8-4
disc copy option 8-4
selecting destination drive 8-3
selecting source drive 8-3
starting 8-2
test options 8-3
types of CDs that can be copied 8-1

CD layout
about 6-3
changing song order 6-8
modifying 6-8
opening 6-9
removing songs 6-8
renaming songs 6-8
saving 6-9

CD-DA 6-1
CD-R

sharing 4-3
using 4-3

CD-R sharing
created with DirectCD 4-3
created with Easy-CD Creator 4-4

CD-ROM drive
changing drive letter 3-4–3-5
cleaning CDs 2-4
driver files 3-4
identifying 3-4, B-3
identifying drive letter 1-36, 2-4
installing application software A-1
MultiRead 4-2
problem reading CDs 3-4
replacing with CD-Writer 1-20
SCSI 2 3-3
sharing data cable 1-9
using CD-RW 4-2

CD-ROM drives
recording audio 6-4

CD-ROM XA 8-2
CD-RW

audio CDs 4-2
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sharing 4-2
sharing with standard CD-ROM 4-2
using 4-1

CDs
cannot find CD 3-4–3-5
capacity A-3
cleaning 2-4
copy prevention feature 3-3
error, cannot find CD 1-37
inserting 2-1–2-2
maintenance 2-4
multi-session 3-4
power loss while writing 3-5
problems inserting 2-2
purchasing 2-3
reading problem 3-4
removing 2-2
rewritable 2-2, A-4
selecting 2-2
supported by CD-Writer drive A-4
unable to locate 3-4
write-once 2-3, 3-4, A-4

CD-Writer drive
audio cable 3-3
booting from 3-3
changing drive letter 3-4–3-5
compatibility problems 3-7
Customer Support B-1
data cable 1-13, 1-35, 1-36
dimensions A-4
disc data capacity A-3
hardware installation 1-2
identifying drive letter 1-36, 2-4
jumper setting 1-8, 1-25, 1-35, 1-36, 1-37
model number B-2
not recognized 1-36, 3-4–3-5
optimizing performance 3-6, A-2
performance A-2–A-3
performance enhancement 3-7
power cable 1-14, 1-19, 1-33, 1-35, 1-36
recording 1-15, 1-29
returning B-8
securing 1-18, 1-32
selecting CDs 2-2
serial number 1-24, B-2
sharing IDE controller 1-35, 1-36, 1-37

speakers 1-15, 1-29
supported discs A-4
system requirements A-1
uninstalling 1-34
using earphones or speakers 3-3

changed files, protection of 9-15
changing song order 6-8
changing text attributes 7-6
cleaning CD-Writer drive 2-4
CMOS boot order settings 3-3
compatibility A-1
compression software 3-6
computer

identifying model B-3
locating IDE controller 1-35
processor speed A-1, A-2
removing cover 1-5, 1-22
removing drive bay cover plate 1-6
replacing cover 1-19, 1-33
sound board 1-15, 1-29, B-3
system requirements A-1

connecting
data cable 1-13
power cable 1-14, 1-28
power cord 1-19, 1-33

connector
data cable 1-10
power 1-14

contacting Customer Support B-1
control panel for HP Simple Trax 9-12
copy prevention feature 3-3
copying

audio CDs 8-1
DirectCD discs 8-2
mixed-mode CDs 8-2
photo CDs 8-2
video CDs 8-2

copying CDs
making mulitple copies 8-4
steps 8-3

copying from CD to CD 3-3
copyright notice 6-2, 8-1
cover plate,removing 1-6
creating a protection list 9-3
creating audio CDs 6-5
CTRL-ALT-DEL 3-5
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Customer Support, contacting B-1
customizing jewel case inserts 7-2

D

data cable 1-11, 1-15, 1-29
connecting 1-13
connector 1-10
sharing 1-35, 1-36, 1-37
troubleshooting 1-35, 1-36

defining text attributes 7-5
Device Manager B-2
digital audio extraction 6-4
dimensions A-4
DirectCD

sharing CD-R 4-3
starting 5-2

DirectCD discs
about formatting CD-RW disc 5-3
adding data 5-4, 5-5
ejecting 5-4
formatting 5-3

disaster recovery 10-1
disaster recovery glossary 10-8
disaster recovery set

creating 10-2
testing 10-3

disc data capacity A-3
disc labels

printing 7-8
disconnecting, power cord 1-5, 1-22
discs

sharing CD-R 4-3
sharing CD-RW 4-2
using CD-R 4-3
using CD-RW 4-1

displaying
grids 7-4
track numbers 7-8
track times 7-8

distortion
audio 3-3–3-4
video 3-4

drive bay 1-6, A-1

installing the CD-Writer drive 1-9
removing cover plate 1-6

drive letter
changing 3-4–3-5
identifying 1-36, 2-4

driver files
CD-ROM drive 3-4

E

earphones 3-3
Easy-CD Audio

Online Help 5-8, 6-10, 7-9, 8-5
wizard 6-3

Easy-CD Creator
sharing CD-R 4-4

eject button 2-1, 2-2
ejecting DirectCD discs 5-4
email 3-6
environmental specifications A-4
erasing files from CDs 5-5
error logs tab in HP Simple Trax 9-15
error message

buffer underrun 3-6–3-7
cannot find CD 1-37, 3-4–3-5
invalid media 3-3
unable to read 3-4

error rate A-3
expanding power connector 1-14

F

fax mode 3-6
files

automatic protection 9-4
changed, protection of 9-15
filters 9-10
protected versions of 9-8
protection history 9-8
protection of 9-2
retrieving 9-6

finding in HP Simple Trax 9-9
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firmware version B-2
fitting tracks on a page 7-8
formatting DirectCD discs 5-3

H

half-height drive bay 1-6
Handling CDs 2-3
hard drive

access time 3-7, A-2
compression software 3-6
speed A-2
storage requirements A-1
transfer rate A-1, A-2

hardware installation 1-2
Help

Easy-CD Audio 5-8, 6-10, 7-9, 8-5
high-pressure air 2-4
history of protection for a file 9-8
HP Simple Trax

control panel 9-12
error logs tab 9-15
protecting files 9-2
protection list 9-3
retrieving protected files 9-6
schedule setup tab 9-14
scheduling a protection session 9-4
selection tab 9-13

humidity specifications A-4

I

I/O address 3-7
IDE controller 1-9, A-1

adding B-4
locating 1-2, 1-35
resource conflicts 3-7
settings B-3
sound board 1-11, 1-35

identifying drive letter 1-36
inserting a CD 2-1–2-2
inserting objects 7-6

Install Assistant A-1
Install Recommendation

data cable 1-11
jumper setting 1-8, 1-25
printout 1-8, 1-11, 1-25

installing
computer cover 1-19, 1-33
master/slave jumper 1-8, 1-25, 1-37

installing application software A-1
installing hardware 1-2
Interchange 4-4
invalid media error 3-3
IRQ channel 3-7

J

jewel case inserts
adding graphics 7-6
editing 7-2
editing text 7-6
graphics

OLE objects 7-6
making 7-2
positioning 7-4
printing 7-8
rulers and grids, using 7-3
viewing 7-2
zooming 7-3

jewel case layout 7-2
Page menu 7-2

jumper setting 1-8, 1-25, 1-35, 1-36, 1-37

M

maintenance 2-4
making a disc copy 8-4
making multiple copies 8-4
master jumper setting 1-8, 1-25, 1-35, 1-36, 1-

37
mastering application 4-4
measuring inserts and objects 7-3
memory A-1, A-2, B-3
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metric screws 1-18, 1-32
model number, locating B-2
modifying CD layouts 6-8
MSCDEX version 3-4
MultiRead CD-ROM 4-2
multi-session CD 3-4
music CDs

playing 6-9

N

networks 3-6

O

OLE objects 7-6
opening CD layouts 6-9
opening tray 2-1
operating system

compatible A-1
identifying B-3

P

paddle board B-4
Page menu 7-2
performance A-2–A-3

optimizing 3-6, A-2
playing music CDs 6-9
positioning objects 7-4
power cable 1-14

connecting 1-14, 1-28
troubleshooting 1-35, 1-36

power connector 1-14
power cord

connecting 1-19, 1-33
disconnecting 1-5, 1-22

power loss while writing 3-5
power management feature 3-1, 3-7
power requirements A-4

printing
disc labels 7-8
jewel case inserts 7-8

printout, Install Recommendation 1-8, 1-11,
1-25

processor speed A-1, A-2
product certification v
programs

running other 3-6
uninstalling 1-34

protecting
automatically 9-4
changed files 9-15
definition of 9-1
files 9-2
schedule for 9-4

protection list, adding files to 9-3
protection, file’s history of 9-8
purchasing

audio cable 1-17, 1-31

R

RAM. See memory
reading error 3-4
reading from CD

speed A-3
recording

CD to CD 3-3
power loss during 3-5
while running other applications 3-6

recording audio tracks 6-3
recording wave files 6-5
recovering your data 10-4
refreshing the screen 3-4, 3-5
removing

computer cover 1-5, 1-22
drive bay cover plate 1-6

removing a CD 2-2
removing songs from CD layout 6-8
renaming songs in CD layout 6-8
replacing a CD-ROM 1-20
replacing computer cover 1-19, 1-33
resource conflicts 3-7
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retrieving
options 9-7
protected files 9-6

returning a CD-Writer drive B-8
rewritable CDs 2-2, 3-4, A-4
ruler option 7-3

S

saving CD layout 6-9
scheduling

protection session 9-4
setup tab in HP Simple Trax 9-14

screws 1-18, 1-32
searching in HP Simple Trax 9-9
securing the CD-Writer drive 1-18, 1-32
selection tab in HP Simple Trax 9-13
serial number 1-24, B-2
sharing CD-R

created with DirectCD 4-3
created with Easy-CD Creator 4-4

sharing CD-R discs 4-3
sharing CD-RW discs 4-2
sharing data cable 1-35, 1-36, 1-37
Simple Trax. See HP Simple Trax
slave jumper setting 1-8, 1-25, 1-35, 1-36, 1-

37
snapping objects to grid 7-4
software

uninstalling 1-34
software compression 3-6
songs

removing from CD layout 6-8
renaming 6-8

sound board 1-15, 1-29, 3-3, B-3
IDE controller 1-11, 1-35

sound system 1-15, 1-29
sound-muting feature 3-3
speakers 1-15, 1-29, 3-3
speed

reading from CD A-3
writing to CD A-2, A-3

system requirements A-1

T

temp directory
changing location 8-4

temperature specifications A-4
test options

CD Copier 8-3
text attributes

changing 7-6
defining 7-5

track column lists 7-7
track titles

arranging 7-7
track-at-once mode 8-1
tracks

combining with wave files 6-2
transfer rate A-1, A-2, A-3
tray, opening and closing 2-1, 2-2
troubleshooting 3-1–3-7

audio cable 3-3
audio distortion 3-3–3-4
booting from CD-Writer drive 3-3
cannot find CD 1-37
copying from CD to CD 3-3
Customer Support B-1
data cable 1-35, 1-36
I/O address 3-7
inserting CDs 1-37, 2-2
invalid media 3-3
IRQ 3-7
not recognizing CD-Writer drive 1-36
power cable 1-35, 1-36
resource conflicts 3-7
returning your CD-Writer drive B-8
sound board 1-35
using the Install Recommendationt 1-35
video distortion 3-4
writing to CD 3-6

types of CDs that can be copied 8-1

U

uninstalling 1-34
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V

vibration specifications A-4
video card 3-4
video distortion 3-4
viewing jewel case inserts 7-2
viewing protected versions 9-8
volume control 3-3

W

wave files 3-4, 6-2
combining with audio tracks 6-2
pre-recording from audio tracks 6-6
recording 6-5
specifications 6-5

windows explorer 6-4
wizard

making music CDs 6-3
write-once CDs 2-3, 3-4, 3-6, A-4
writing to CD 1-15, 1-29, 3-3, 3-6

power loss while writing 3-5
speed A-2, A-3

Y

Y-power cable 1-14
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